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1. Introduction

This document is the user manual for the UNITROL 1005 automatic voltage regulator (AVR) 
that is used for the excitation of indirectly excited synchronous machines.

Read and understand this document before you do any work on the product.
Before you install or operate the product, refer to Safety on page 13.
You are expected to know the fundamentals of electricity, wiring, electrical components and 
electrical schematic symbols.

1.1 Intended audience
This document is intended for trained professionals who

• Plan the installation of

• Install

• Operate

• Do maintenance on

UNITROL 1005 automatic voltage regulators.

1.2 Related documents
Refer to the inner front cover.

1.3 Copyright and content information
ABB reserves all rights to this document and to the information and topics contained in it. 
This also applies to any possible claims to copyright or patents. Forwarding and/or the 
duplicating of this document without the express permission of ABB is forbidden.

This document has been prepared and checked with great care. If however it still contains 
errors, please report them to ABB.

1.4 Generic disclaimer
The manufacturer shall have no obligation hereunder with respect to any product which

(i) has been improperly repaired or altered

(ii) has been subjected to misuse, negligence or accident

(iii) has been used in a manner contrary to the Manufacturer's instructions

(iv) has failed as a result of ordinary wear and tear.

All material in this manual is subject to change without a further notice, manual is intended as 
non-contractual document.
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1.5 Cyber security disclaimer
This product is designed to be connected to and to communicate information and data via a 
network interface. It is customer's sole responsibility to provide and continuously ensure a 
secure connection between the product and customer network or any other network (as the 
case may be). It is customer's sole responsibility to establish and maintain any appropriate 
measures (such as but not limited to the installation of firewalls, application of 
authentication measures, encryption of data, installation of anti-virus programs, etc.) to 
protect the product, the network, its system and the interface against any kind of security 
breaches, unauthorized access, interference, intrusion, leakage and/or theft of data or 
information. Notwithstanding any other provision to the contrary and regardless whether the 
contract is terminated or not, ABB, its subcontractors, its and their affiliates and its and their 
employees are under no circumstances liable for and the Customer shall defend and 
indemnify said parties from and against any claim for damages and/or losses related to any 
such security breaches, unauthorized access, interference, intrusion, leakage and/or theft or 
loss of data or information.

1.6 Documentation, software and tools
You can get access to the latest documentation, software and tools for the AVR on the 
myABB business portal.

To get access:

1. Go to https://myportal.abb.com in your web browser.

2. Select Log In.

• If you have an ABB account, you can sign in with your 
email and password.

• If you do not have an ABB account, refer to How to 
register to the myABB business portal on page 9.

3. After you log in, the myABB dashboard opens.

4. On the myABB dashboard, find the myExcitation widget.
For information on how to register to the myExcitation 
widget, refer to How to register to the myExcitation 
widget on page 9.

5. In the myExcitation widget in the myABB business 
portal, select GO TO ABB LIBRARY.

6. ABB Library opens in the Category view.

7. In the left-hand menu, select ABB products > Power Electronics > UNITROL Excitation 
Systems > UNITROL 1000 > UNITROL 1005.

8. You can search for documents by document kind. Click Category to open other filters.

9. Click Document kind. You can select the document kind from a list.
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10. You can write a search word in the search box.

11. If necessary, select a document language or sort the results by relevancy or date.

12. Select the documentation, software or tool for your AVR.

13. You can download the documents to your PC.

1.6.1 How to register to the myABB business portal
1. Select Sign up below the LOGIN button.

2. Fill in the registration form.

3. Select Sign up.

4. ABB sends you an email to activate your ABB account.

5. In the email, select ACTIVATE ACCOUNT.

6. You now have access to the myABB business portal.

1.6.2 How to register to the myExcitation widget
1. In the myExcitation widget in the myABB business portal, select GET ACCESS.

2. Fill in the registration form.

3. You now have access to the myExcitation widget.
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1.7 Support information
If you have questions, contact your local ABB representative or the manufacturer:

Note! When you call ABB, please give your name, department and phone number. This 
allows the responsible ABB representative to call back without delay.

ABB Switzerland Ltd
Static Excitation Systems, Voltage Regulators
and Synchronizing Equipment
CH-5300 Turgi / Switzerland

Internet: http://www.abb.com/unitrol

24 h – Hotline for urgent service inquiries: +41 844 845 845

Email contact for questions and UNITROL 1000 support: 
unitrol1000.supportline@ch.abb.com

http://www.abb.com/unitrol
mailto:unitrol1000.supportline@ch.abb.com
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1.8 Terms and abbreviations

Term Description

AC Alternating current

AI, AO, AIO Analog input, analog output, analog input and output

AUTO Automatic voltage regulation (Auto mode)

AVR Automatic voltage regulator

Batt Battery

CAN Controller-area network

CB Circuit breaker

CMT 1000 Commissioning and maintenance tool

CT Current transformer

DC Direct current

DI, DO, DIO Digital input, digital output, digital input and output

ESD Electrostatic discharge

ETH Ethernet terminal

EXC Excitation

FCB Field circuit breaker

FCR Field current regulation

GEN Generator

GFR Ground fault relay (Rotor Ground Fault Protection)

HW Hardware

IGBT Insulated gate bipolar transistor

I/O Input/output

MAIN Main channel in double channel systems.

MANUAL Excitation current regulation (Manual mode)

MCU Micro-controller unit

PC Personal computer

PCB Printed circuit board

PE Protective earth (protective ground)

PF Power factor

PPE Personal protective equipment

PS Power supply



INTRODUCTION 

12

PSS Power system stabilizer

PT Potential transformer

PWM Pulse-width modulation

Q Reactive power

RDM Rotating diode monitoring

SM Synchronous machine

SW Software

UMAUX UM auxiliary input measurement

VAR Reactive power

V/Hz Volt per Hertz (-Limiter)

VDC Voltage droop compensation

VM Voltage matching

Term Description
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2. Safety

Obey the safety instructions in this document when you install, operate and do maintenance 
on the excitation system. Failure to obey the safety instructions increases the risk of electric 
shock and damage to the equipment.

2.1 Warnings in the documentation
This document uses the warnings and notes that follow:

Note! Notes give important or useful information.

DANGER

• Obey the safety instructions to prevent injury or death, or damage to the 
equipment.

• Read and make sure that you understand the operating and safety 
instructions before you operate the unit.

• If you are not a qualified electrician, do not do electrical installation or 
maintenance work.

• Use personal protective equipment, such as, safety shoes and gloves.

• Before you do any work on the system, refer to Electrical safety precautions on 
page 15.

DANGER

DANGER identifies a hazard with a high level of risk that can cause serious injury 
or death.

WARNING

WARNING identifies a hazard with a medium level of risk that can cause serious 
injury or death, or damage to the machine.

CAUTION

CAUTION identifies a hazard with a low level of risk that can cause minor or 
moderate injury, or damage to the equipment.
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2.1.1 Warning symbols
The symbols in warnings identify the type of warning. Example warning symbols:

The equipment can have warning symbols that are not shown here. Obey the warning text of 
these warnings.

2.2 Requirements for personnel
Personnel involved in installation work and commissioning of the AVR must be trained and 
know about the residual danger areas according to the local regulations. Refer to Residual 
danger areas on page 16.

Only authorized maintenance personnel can do maintenance and repair work on the 
equipment.

The maintenance personnel must know about the emergency shutdown measures and must 
be able to stop the system if there is an emergency.

The maintenance personnel must be familiar with the accident prevention measures at their 
workplace and must be trained in first aid and firefighting.

It is the responsibility of the owner to ensure that each person that does the installation and 
commissioning of the equipment is trained to do so, has a correct education in accordance 
with the local law, and has read and understood the safety instructions.

General warning – Conditions, other than those caused by electricity that can 
cause injury or death, or damage to the equipment.

Electricity warning – Electrical hazards that can cause injury or death, or 
damage to the equipment.

Electrostatic sensitive equipment warning – Risk of electrostatic discharge 
that can cause damage to the equipment.

Hot surface warning – Risk of injury due to high temperatures.
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2.3 Safety instructions
Obey these safety instructions when you do any work on the equipment:

• Use the device only as specified in the technical data (refer to Technical data on page 97) 
and when it is fully operational.

• Only trained personnel can install, operate, do maintenance on or repair the excitation 
system.

• Do not modify the equipment in any way.

2.3.1 Electrical safety precautions
Obey these safety precautions before you do any work on the system:

1. Clearly identify the work location and equipment.

2. Disconnect all possible voltage sources. Make sure that reconnection is not possible. Lock 
out and tag out.

• Open the main disconnecting device of the AVR.

• Disconnect any external power sources from the control circuits before you do any 
work on the control cables.

• If you have a permanent magnet generator connected to the AVR, disconnect it from 
the AVR with a safety switch or by other means.

• After you disconnect the AVR, always wait for 5 minutes to let the intermediate circuit 
capacitors discharge before you continue.

3. Protect any other energized parts in the work location against contact.

4. Take special precautions when you are close to bare conductors.

5. Measure that the installation is de-energized.

• Use a multimeter with an impedance of at least 1 Mohm.

• Make sure that the voltage between the AVR input power terminals (PWR L1, PWR L2, 
PWR L3, PWR L4) and the grounding terminal (PE) is close to 0 V.

• Make sure that the voltage between the AVR output terminals (IE+, IE-) and the 
grounding (PE) is close to 0 V.

6. Install temporary grounding as required by the local regulations.

7. Ask for a work permit from the person in control of the electrical installation work.
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2.3.2 Residual danger areas
When the AVR operates,

• The voltage in the power section can be up to 300 V AC and the short-circuit current is 
very high.

• The voltage in the control cabinet is > 50 V.

When the AVR is disconnected from power supplies, the large capacitors in the AVR hold a 
charge for some time. Wait for at least 5 minutes for the capacitors to discharge before you 
do any work on the AVR.

Warning labels are attached to all of the cubicle doors to warn personnel against opening the 
doors during operation.

If the device is built into a larger system, additional warning labels are attached to the inside 
of the cubicle doors and to the covers of the power converter modules.

Consider the residual danger areas when you do any work on the excitation system:

• Danger from live equipment inside the excitation system, if the protective covers are 
removed.

• Hazardous voltages from the rotor field winding and the secondary side of the excitation 
transformer.

• Capacitors can still be charged if a power section door is opened immediately after the 
system is stopped.

• Danger from the main and auxiliary voltages in cubicles when cubicle doors are open.

WARNING

Be careful when you install or replace the AVR. There is a risk of electric shock.
The AVR has large capacitors, which can have a charge for a short time after you 
disconnect the AVR from power.

WARNING

Before you do any work on the AVR, measure to make sure that the input voltage 
is less than 30 V AC or DC.
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2.4 Instructions for emergency situations
Obey the safety instructions in this section for the specific emergency situations.

2.4.1 Firefighting

All personnel must know the location of fire extinguishers and emergency exits and must be 
able to operate the fire extinguishers.

Fire extinguishers are carbon dioxide (CO2) or foam-based:

• Use Carbon dioxide (CO2) fire extinguishers to fight fires in electrical installations.
Do not use them on persons.

• Use Foam extinguishers to fight fires in non-electrical equipment.
You can use them on persons but not on electrical equipment.

If there is a fire:

1. Stop the system.
Make sure that the operators know the emergency shutdown sequence.

2. Put on a protective mask.

3. Use a carbon dioxide (CO2) fire extinguisher to extinguish the fire. Do not use foam or 
water.

2.4.2 First aid measures for electrical installations

If there is an emergency:

1. Stop the plant.
Make sure that the operators know the emergency shutdown sequence of the system.

2. Switch off all power supplies and ground the system.

3. Carefully remove the injured person from the dangerous location.

4. Call for emergency assistance.

5. Provide first aid for electric shock.

DANGER

In case of fire, be aware of dangerous voltages, toxic gases and overheating.

DANGER

Do not touch the injured person until the system is grounded. There is a danger of 
electric shock.
Residual voltage of the rotating machine is present immediately after the system 
stops.
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2.4.3 Pacemaker

Electrical and magnetic fields can cause interference to pacemakers. It is difficult to predict 
the sensitivity of pacemakers to interference.

2.5 Danger signs
Danger signs are attached to equipment or locations that have a risk of danger.

The degree and likelihood of such dangers are described by the signal words DANGER, 
WARNING and CAUTION. The content of the warning sign tells you about the respective 
situation and the preventive safety measures.

Example signs with the meaning of the signal words:

DANGER

Do not stay close to the excitation system. The electrical and magnetic fields of 
the excitation system can cause malfunctions of pacemakers.

Sign Description

DANGER, electrical
This symbol identifies imminent danger that 
will cause life-threatening physical injury or 
death.

WARNING, electrical
This symbol identifies a dangerous situation 
that can cause serious physical injury or 
death.

CAUTION, electrical
This symbol identifies a possible dangerous 
situation that can cause moderate physical 
injury.
This signal word is also used for warnings 
related to equipment damage.

   

 

DANGER

   

 

WARNING

   

 

CAUTION
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3. Device overview

The automatic voltage regulator (AVR) is used for the excitation of indirectly excited 
synchronous machines. The AVR can operate as a voltage regulator, a reactive power 
regulator, power factor regulator or field current regulator, and is designed for excitation 
currents of up to 5 A nominal.

The AVR has several control modes that depend on the generator state. By default, the AVR is 
controlled by digital inputs. You can use the commissioning and maintenance tool CMT 1000 
on your PC to locally operate the AVR. To operate the AVR remotely, you can use remote 
access with the Modbus protocol. 

3.1 Hardware overview
This section gives an introduction to the hardware. For more information on the hardware, 
refer to Mechanical installation on page 22, Electrical installation on page 25 and Technical 
data on page 97.

1

No. Description
1 Mounting holes

2 Unit type designation

3 Front cover

4 Ethernet port

5 USB port

6 Power terminals
• Protective earth (PE)
• Input power UPWR

• Excitation output Ie + Ue

7 Measurement terminals
• Network voltage UNET

• Machine voltage UM

• Machine current IM
8 Digital and analog I/Os

9 Status LEDs

10 Heat sink

1

11

10
2

3

4 5

7

6

8

9
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3.1.1 Status LEDs

3.2 Control interfaces
To control the AVR, you can use:

• Digital and analog inputs and outputs

• CMT 1000 commissioning and maintenance tool with USB or Ethernet connection

• Remote access with Ethernet or RS-485 connection

For information on access levels and priorities of the operators, refer to Operators and 
access levels on page 90.

For more information on remote access and Modbus protocols, refer to the Modbus 
Reference Manual (3BHS358281 E80).

3.2.1 Digital and analog inputs and outputs
You can control the AVR with digital and analog inputs and outputs. Digital and analog I/Os 
have the highest priority by default. You can change the polarity of digital inputs during 
commissioning only.

3.2.2 CMT 1000
You can operate and control the AVR locally on your PC with CMT 1000 software during 
commissioning or maintenance work. Use the USB or Ethernet connection. Disconnect the 
CMT 1000 after you have completed commissioning or maintenance work.

3.2.3 Remote access with Modbus
You can operate and control the AVR from remote locations with Modbus TCP as an 
application protocol. Use the Ethernet connection for Modbus communication.

Color Description
Green Operating status

ON: Device controller is active
Flashes: Device software is active

Yellow Excitation status
ON: Excitation is active
Flashes: A limiter is active

Red Alarm status
ON: An alarm or a trip is active
Flashes:
• Startup failure
• Parameter download failure
• Excitation output is blocked
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The remote access is fully interoperable with CMT 1000. Both interfaces can have monitor 
access at the same time. The micro-controller unit (MCU) of the AVR automatically gives or 
denies control access.

Cyber security note: Modbus does not natively guarantee secure communication. 
Any node able to communicate with the AVR via Modbus can perform unwanted 
changes or incorrect configurations on such products that can disrupt the 
intended operation of the AVR and the systems connected to it. It is recommended 
to limit the Modbus communication within trusted networks and to strictly control 
accesses to such networks.

3.3 Software overview
The device software of the AVR has control modes for different functions. A set of software 
options is available for each AVR. For information on the device software, refer to Device 
software on page 38 and the UNITROL 1000 Control SW manual (3BHS399489 E02).

3.3.1 Control modes
The AVR has several control modes, for example:

• Auto mode

• Manual mode

• PF mode

• VAR mode

• Open Loop mode

3.3.2 Software options
You can select a software package that has a default set of software options. To enable more 
software options, send a password request to ABB. For more information, refer to Software 
options on page 44.

3.4 Commissioning and maintenance tool 
CMT 1000
CMT 1000 is a commissioning and maintenance tool for the AVR. You can use CMT 1000 on 
your PC to set the parameters of the AVR. You can monitor the system with instruments, for 
example, Oscilloscope, PQ Monitor and History Logger.

For information on CMT 1000, refer to Commissioning and maintenance tool CMT 1000 on 
page 54.
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4. Mechanical installation

This chapter tells you how to mechanically install the AVR. Only trained and certified 
personnel can install the AVR. Obey the safety instructions in Safety on page 13.

4.1 Product package

Contents of the product package:

• UNITROL 1005 AVR

• Special red USB cable that is used to communicate with and to power the AVR. Keep this 
USB cable in a safe place.

• Quick installation guide

• Test certificate

Open the product package:

1. Carefully open the product package.

2. Make sure that all of the listed items are in the product package.

3. Visually examine the AVR to make sure that it does not have any external damages.
If the product package has a damage, speak to your local ABB representative.
Do not use a product that has a damage.

WARNING

Do not install or use a product that has a damage.
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4.2 Installation area
Install the AVR in an indoor area that is dry and dust-free, and that does not contain volatile 
gases, acid fumes or similar hazards.

Examine the installation area and refer to Technical data on page 97 to make sure that:

• The maximum ambient temperature is in the permitted range.

• The vibration is limited and within the permitted class.

• The ingress protection and pollution degree are suitable.

• The EMC environment is suitable.

4.3 Mechanical installation requirements
• Free space requirements:

• 10 mm on the terminal side of the AVR

• 30 mm on the other sides of the AVR

• Make sure that there is sufficient cooling air flow 
around the AVR.

• Make sure that other devices do not blow hot air 
on to the AVR.

• The AVR is designed to be installed with suitable 
hardware to an installation plate.

• Make sure that the frame of the AVR is electrically 
grounded (PE) to the installation plate with a 
grounding wire (≥4 mm2) through a mounting 
hole. Use toothed washers to get a good electrical 
ground connection.

30 mm30 m 10 mm

30 mm
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4.4 Mechanical installation procedure

To install the AVR:

1. Refer to Dimensions on page 97 for the mounting 
hole dimensions.

2. Make the appropriate holes in the installation 
plate.

3. Attach the AVR to the installation plate with 
suitable hardware, for example, M6 screws to a 
torque of 10 Nm. The mounting holes have a 
diameter of 6.5 mm.

4. Make sure that there is a good electrical ground 
connection between the installation plate and the 
AVR. The installation plate must be electrically 
grounded (PE).

WARNING

Obey the safety instructions in Safety on page 13 to prevent injury or death, or 
damage to the equipment.

WARNING

Before you start the installation, make sure that the AVR is disconnected from all 
power sources.



 

25

5. Electrical installation

This chapter gives instructions for the electrical installation of the AVR.

Before you start the electrical installation, read and obey the safety instructions in Safety on 
page 13. Only trained and certified personnel can install the AVR.

5.1 Electrostatic-sensitive components
Use electrostatic discharge (ESD) protection when you do any work on printed circuit boards 
or other sensitive electronic components.

WARNING

Obey the safety instructions in Safety on page 13 to prevent injury or death, or 
damage to the equipment.

WARNING

Before you start the installation, make sure that the AVR is disconnected from all 
power sources.

CAUTION

• Use ESD protection such as a wrist grounding strap.

• Hold printed circuit boards only at the edges.

• Put the component on a grounded work surface that has protection against 
electrostatic discharges.

• Electrostatic discharge can cause damage to printed circuit boards and 
electronic components.
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5.2 Connection diagram
Simplified connection diagram for the AVR.

No. Description No. Description

1 Digital I/Os
Maximum cable length 30 m

7 Measurement and control unit (DSP)

2 Analog I/Os
Maximum cable length 30 m

8 Power electronic control
(PWM)

3 Network voltage measurement UNET 9 Communication micro-controller unit 
(MCU)

4 Machine voltage measurement UM 10 USB connection
Maximum cable length 3 m

5 Machine current measurement IM2 11 Ethernet connection
Maximum cable length 100 m

6 Excitation output Ie + Ue 12 Excitation power supply input
PWR L1–L4

SM E

7

5

4

3

2
1

6

6
12

11

10

9

8
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5.3 Excitation cabling requirements
The excitation cables refer to the power and measurement cables at terminals 1-15.

The system obeys the emission limits of standard EN 61000-6-4 if the connections for the 
power electronics supply and the field output use shielded cables that are grounded at each 
end.

5.4 Control cabling requirements
The control cables refer to the digital and analog I/O cabling at terminals 21-53. 

Requirements for the control cables based on cable lengths:

• <3 m: Grounding is not necessary.

• 3–10 m: Use a twisted-pair cable.

• 10–30 m: Use a shielded cable with one PE connection near the AVR.

• >30 m: Not permitted.

The digital and analog ground is connected directly to the protective earth (PE).

5.5 Cable routing and dimensioning
Make sure that the routing of the excitation cables is not connected with the control cables. 
Separation of the cable routing is necessary to prevent electromagnetic interference. Refer to 
Device connections on page 29.

Cable dimension requirements:

CAUTION

Use shielded cables for excitation cables that are longer than 3 m.
If the excitation cables are not shielded, there is a risk of electromagnetic 
interference.

Connection type Cross-section area requirement
Excitation cables
Terminals 1 to 15 0.2–4.0 mm2 AWG 24 to AWG 10

Control cables
Terminals 21 to 53 0.2–1.5 mm2 AWG 24 to AWG 15
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5.6 Grounding (PE) requirements
Connect the AVR to the protective earth at terminal 1 with a 4 mm2 grounding wire.

Make an additional ground connection through the mounting holes to the installation plate 
(if it is connected to the protective earth) or with a 4 mm2 cable to the protective earth.

Make sure that the ground connections are as short as possible.

Additional signal ground terminals are provided for the control cables.

5.7 Inrush current limitation
A high inrush current can occur when you apply supply voltage. 

To prevent damage to the AVR from a high inrush current:

5.7.1 External MCB requirements

The AVR has a crowbar firing thyristor. You can set a monitor function that triggers the firing 
and stops the excitation by tripping the external fuse device.

Use MCB type C fuses with a nominal rating of 6 A.

CAUTION

To prevent damage to the AVR, make sure that the inrush current is not > 100 A for 
10 ms.

Method Description

Shunt supply The excitation power is taken from the generator output over a shunt 
transformer. Use an excitation supply transformer with a maximum 
power of 3 kVA.

PMG supply The excitation power is taken form a permanent magnet generator 
(PMG). The maximum permitted output power of the PMG is 3 kVA.

Auxiliary 
windings

The excitation power is taken from an additional stator winding of the 
generator.

DC battery The excitation power is taken from a battery. Limit the inrush current 
with a resistor.

CAUTION

Fuses with > 6 A nominal short-circuit current can damage the AVR.
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5.8 Device connections
Overview of the AVR terminals and connection ports.

1

No. Description
1 Power terminals

2 Measurement terminals

3 Digital and analog I/Os

4 Ethernet port

5 USB port

2

3

4 5
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5.8.1 Power and measurement terminals
Terminal descriptions for the power and measurement terminals of the AVR.

Power and measurement terminals Type Ref. Label Description

Po
w

er
 t

er
m

in
al

s

1 PE Protective earth

2 PWR L1 Input power L1

3 PWR L2 Input power L2

4 PWR L3 Input power L3

5 PWR L4 Input power L4

6 IE + Excitation current +

7 IE - Excitation current -
M

ea
su

re
m

en
t 

te
rm

in
al

s

8 ML1 Machine voltage L1

9 ML2 Machine voltage L2

10 ML3 Machine voltage L3

11 NW1 Network voltage L1

12 NW3 Network voltage L3

13 MC2+ (5A) Machine current 5 A +

14 MC2+ (1A) Machine current 1 A +

15 MC2- Machine current -
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5.8.2 Digital and analog I/O terminals
Terminal descriptions for the digital and analog I/O terminals of the AVR.

Type Ref. Label Description

Digital I/O 
terminals

21 G1 GND, connected to PE (PELV)

22 O1A Digital output 1, potential-free, positive

23 O1B Digital output 1, potential-free, negative

24 G2 GND, connected to PE (PELV)

25 O2A Digital output 2, potential-free, positive

26 O2B Digital output 2, potential-free, negative

27 V2 2  V output, connected to other Vx (PELV)

28 DO3 Digital output 3 (PELV)

29 DO4 Digital output 4 (PELV)

30 V3 24 V output, connected to other Vx (PELV)

31 DI5 Digital input 5 (PELV)

32 DI6 Digital input 6 (PELV)

33 V4 24 V output, connected to other Vx (PELV)

34 DI7 Digital input 7 (PELV)

35 DI8 Digital input 8 (PELV)

36 V5 24 V output, connected to other Vx (PELV)

37 DI9 Digital input 9 (PELV)

38 DI10 Digital input 10 (PELV)

39 V6 24 V output, connected to other Vx (PELV)

40 DI11 Digital input 11 (PELV)

41 DI12 Digital input 12 (PELV)

53

25

50

22

47 44 41 38 35 32 29 2326

454851

52 49 46 43 40 37 34 31 28

2124273033363942
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Analog I/O 
terminals

42 G3 Analog ground, connected to PE (PELV)

43 BI1 Analog input 1, negative (PELV)

44 AI1 Analog input 1, positive (PELV)

45 G4 Analog ground, connected to PE (PELV)

46 CN1 Configuration terminal for 20 mA input (PELV)

47 CP1 Configuration terminal for 20 mA input (PELV)

48 G5 Analog ground, connected to PE (PELV)

49 BI2 Analog input 2, negative (PELV)

50 AI2 Analog input 2, positive (PELV)

51 RP + 10 V positive reference (PELV)

52 CN2 Configuration terminal for 20 mA input (PELV)

53 CP2 Configuration terminal for 20 mA input (PELV)

Type Ref. Label Description

53

25

50

22

47 44 41 38 35 32 29 2326

454851

52 49 46 43 40 37 34 31 28

2124273033363942
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5.9 Terminal and signal data
The table lists the terminal and signal data, and gives a circuit description.

Terminal Signal Circuit description

1 = PE Protective earth

2 = PWR L1
3 = PWR L2
4 = PWR L3
5 = PWR L4

Power electronics and control 
supply UPWR

• Main L1
• Main L2
• Main L3
• Main L4

Caution! The maximum 
inrush current must not be 
> 100 A within 10 ms. Refer 

to Inrush current limitation on page 
28.

Note! To get a 6 V AC start 
level, use L1 and L2.

6 = IE +
7 = IE -

Excitation current output Ie
• Exciter current +
• Exciter current -

8 = ML1
9 = ML2
10 = ML3

13, 14 = 
MC2+
15 = MC2-

8 = ML1
10 = ML3

8 = ML1
9 = ML2
10 = ML3

Machine voltage three-phase UM

• Machine L1
• Machine L2
• Machine L3

Machine current single-phase IM2

• Machine current +
• Machine current -

Machine voltage single-phase UM

• Main L1
• Main L3

Machine voltage three-phase with 
ground UM

• Machine L1
• Machine L2
• Machine L3

1) You must ground PTs and CTs.

L1, L2, L3, L4

L1, L2

L1, L2

3~

1~

2=

Absolute max. values

16...300 V AC

16...300 V AC

16...300 V DC

E
IE-

External

0 to 300 V DC

5 A DC

ML1
ML2
ML3

ML1
ML2
ML3

L1 L2 L3

ML1
ML3

MC2+

MC2-

SM

IM2

External

External

External

max. 500 V / 0.2 VA

max. 500 V / 0.2 VA

max. 500 V / 0.2 VA

1 A / 5 A

1)

1)

1)

1)
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11 = NW1
12 = NW2

Line voltage measurement single-
phase UNET

• Network L1
• Network L3

1) You must ground PTs and CTs.

22 = OA1
23 = OB1
25 = OA2
26 = OB2

Digital output, potential-free
• Digital output, collector
• Digital output, emitter
• Digital output, collector
• Digital output, emitter

27, 30, 33, 
36, 39 = Vn

21, 24, 42, 
45, 48 = Gn

24 V supply for external contacts
• 24 V DC output (maximum 50 mA)
• An alternative supply for the 

internal controller
• Digital ground, connected to PE

28 = DO3
29 = DO4

21 = G1
24 = G2

Digital output
• Digital output 3
• Digital output 4

• Digital ground, connected to PE
• Digital ground, connected to PE

Note! The open collector 
transistor can switch up to 
500 mA peak and 200 mA 
continuously.

31 = DI5
32 = DI6
34 = DI7
35 = DI8
37 = DI9
38 = DI10
40 = DI11
41 = DI12

30 = V3
33 = V4
36 = V5
39 = V6

Digital input
• Digital input 5
• Digital input 6
• Digital input 7
• Digital input 8
• Digital input 9
• Digital input 10
• Digital input 11
• Digital input 12

• 24 V power
• 24 V power
• 24 V power
• 24 V power

Terminal Signal Circuit description

 

NW1
NW3

1)

External

max. 500 V / 0.2 VA

O1A

O1B

External

Vx

Vx

Gx

24V

max. 50 mA

20...28 V DC

Vx
Vx

DOx

Gx

External

Ext. PWR 
supply 

24 V DC

max. 50 mA

24 V

24 V

ADC

2 k

Vx

Gx

External

20...28 V DC
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Note! The internal 24 V supply (V1 to V6) can be loaded with a maximum of 50 mA 
by all used digital inputs and outputs. If the power consumption is higher, use an 
external power supply.

Terminal 
designation

Signal Circuit

44 = AI1
43 = BI1
50 = AI2
49 = BI2

51 = RP

42, 45, 48 = 
Gx

Analog inputs ±10 V DC AIx/BIx

Signal bandwidth 100 Hz

+10 V positive reference

GND positive reference

R = 10 kOhm
Input range 0 V to 9.1 V

44 = AI1
43 = BI1
50 = AI2
49 = BI2

47 = CP1
46 = CN1
53 = CP2
52 = CN1

Analog inputs 20 mA

AIx/BIx ; CPn/CNn

Signal bandwidth 100 Hz
Note! Add a jumper 
between CPx and CNx to 
enable a 20 mA input.

44 = AI1
43 = BI1
50 = AI2
49 = BI2

51 = RP

Analog inputs digitally assigned

AIx/BIx

Refer to Analog inputs on page 50.
Note! If the two switches 
are active at the same time, 
no digital inputs are 
activated.

+

-

+

-

+

-

AIx

BIx

AIx

RP

BIx

Gx

R

External

+

-

+

-

AIx

BIx

CPx

CNx

External
max. 20 mA

+

-

RP

AIx

BIx
Ain
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5.10 Communication ports
The AVR has two communication ports that you can use at the same time:

• The USB port connects the AVR to the PC with a USB cable. CMT 1000 uses the USB for 
communication with the AVR.

• The Ethernet port connects the AVR to a multi-point network. You can use Ethernet for 
remote access with the Modbus TCP protocol. You can also use the Ethernet port for a 
direct connection to a PC.

5.10.1 USB port
Use the USB port to connect the AVR to a PC to use the CMT 1000 commissioning and 
maintenance tool. To connect a PC to the AVR, use the supplied red USB cable. The USB port 
powers up the control devices of the AVR so you can download or upload parameter files 
without an additional power supply connection.

Note! Use only the red USB cable that is supplied with the AVR. If you use a 
different cable, it can cause a communication failure or power supply over USB can 
be incorrect.

Note! Some options are disabled, when the unit is powered only with the USB cable.

5.10.1.1 Power over USB cable only

When the AVR is powered only with the USB cable:

• The main window of CMT 1000 shows a yellow error indication on the access level 
indicator.

• The IGBT power stage is disabled. If the AVR input voltage is < 6 V AC, it is not possible to 
use the regulators.

• It is not possible to update the software or enable software options.

max 3 m
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5.10.2 Ethernet port
Use the Ethernet port to connect the AVR to a multi-point network. You can monitor and 
control the AVR from a remote location. In an Ethernet network you can use remote access 
with the Modbus TCP protocol. You can also connect the AVR directly to a PC with the 
Ethernet connection. It is possible to monitor the AVR from CMT 1000 and a plant control 
system at the same time.

For information on the Modbus protocol, refer to the Modbus Reference Manual (3BHS358281 
E80).
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6. Device software

This chapter gives a description of the device software: the control modes and setpoints, 
available software options, and digital and analog I/O signals. 

For information on the control features of the device software, refer to the Control SW 
manual (3BHS399489 E02).

For instructions on how to update the device software, refer to Update the device software 
on page 70.

6.1 Control modes
The AVR has several control modes that you can select. The Channel Follow-up function 
allows a soft surge-free transition between the control modes (refer to Channel Follow-up on 
page 39).

6.1.1 Auto mode
• Regulates the terminal voltage of the synchronous machine (UM)

• Voltage setpoint adjustment by static droop that is based on active or reactive current 
measurements

• Auto mode is the default control mode

6.1.2 Manual mode
• Regulates the excitation current (Ie)

• Defines the dynamic performance of the Ie limiter

Note! Limiters are not active in Manual mode.

6.1.3 PF mode
• Regulates the power factor of the synchronous machine

• PF setpoint is based on the active power measurement and VAR setpoint

• You can use PF mode for direct or indirect control of the power factor

• Adjust the voltage setpoint to regulate indirect PF

6.1.4 VAR mode
• Regulates the reactive power of the synchronous machine

• Defines the dynamic performance of PQ Limiter

• VAR setpoint is normalized at 1 pu terminal voltage of the synchronous machine

• You can use VAR mode for direct or indirect control of the reactive power

• Adjust the voltage setpoint to regulate indirect VAR
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6.1.5 Open Loop mode
• Overrides the excitation output of the AVR

• Set a defined AVR output for commissioning and identification of system data

• The excitation voltage (Ue) is directly defined by the multiplication of the PWM signal with 
the rectified input voltage of the AVR (UPWR)

Note! Limiters are not active in Open Loop mode.

6.1.6 Standby mode
• Standby mode is used only in the redundant channel in a double channel system. Refer to 

Double Channel (DCH) software on page 52 and the Control SW manual 
(3BHS399489 E02).

• There is no AVR output in Standby mode

• Setpoints and operation points are calculated from the measurements of the redundant 
channel

6.1.7 Channel Follow-up
When you change between the control modes, the setpoint of the next control mode follows 
the setpoint of the active control mode. This software feature is called Channel Follow-up. 
Channel Follow-up ensures that the operation point of the synchronous machines stays 
correct and surge-free.

For example, when you change from Auto mode to Manual mode, the manual setpoint follows 
the auto setpoint:

• The ramp rate defines how quickly it is possible to change the setpoint.

• If the new setpoint is within the setpoint limit, you can make a surge-free transition 
between the control modes.
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6.2 Priority of control modes
The priority of control modes defines which signal overrides another signal. Priority 1 is the 
highest priority. For example, if the digital input “Standby” is active, all other digital inputs of 
the control modes are ignored.

The priority of control modes:

1) Synchronization with a closed generator circuit breaker (GCB) regulates Q to 0 % (unload function).

2) Auto mode is the default. No digital input is necessary for Auto mode.

Generator states NoLoad Prim. /
Sec. Net

Grid

Control mode Remarks Priority GCB open GCB closed
Not 

connected 
to grid

Connected to 
grid

Standby Hot standby
(any mode)

1
YES YES YES

Sync Synchronization 
(AUTO SP)

2 YES YES1 YES1

Manual Excitation current 
regulation

(MANUAL SP)

3
YES YES YES

Open Loop Excitation output 
regulation
(PWM SP)

4
YES YES YES

VDC Voltage droop 
compensation

(AUTO)

5
BLOCKED YES BLOCKED

PF Direct PF
(VAR SP)

6
BLOCKED BLOCKED YES

VAR Direct VAR
(VAR SP)

7
BLOCKED BLOCKED YES

Indirect PF Superimposed PF
(AUTO SP)

6
BLOCKED BLOCKED YES

Indirect VAR Superimposed VAR
(AUTO SP)

7
BLOCKED BLOCKED YES

AUTO2 Voltage control 8 YES YES YES
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6.3 Setpoints of the control modes
You can adjust the setpoints in the Setup menu > Setpoints. The control modes have the 
setpoint parameters that follow:

• Minimum

• Maximum

• Ramp rate

• Initial setpoint

6.3.1 Initial setpoint
An initial setpoint is used:

• At the start of excitation

• If the generator status changes

• When the digital input “Excitation ON” is not active

You can set a new value for the initial setpoint of a control mode within the range.

6.3.2 Setpoint with an open GCB
When the signal “Gen CB Closed Status” is not active, all setpoints are immediately set to the 
values that follow:

Control mode Default initial 
setpoint

Range of initial 
setpoints

Auto 100 % Min SP - Max SP

Manual 0 % 0 - 150 %

Open Loop 0 % 0 - 100 %

PF 1.0 -1.0 - +1.0

VAR 0.0 % -100 - +100 %

Control mode Final value
Manual 90 % of Ie No load

Open Loop 90 % of 1/Kceil

Auto 100 %
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6.3.3 Reset setpoint
When the signal “Reset Setpoint” is active:

• The setpoint of the control mode goes to the value that follows in accordance with the 
defined ramp rate:

• Or if you select the parameter “Reset SP to initial value”, the setpoint of the control mode 
goes to initial setpoint (Setup menu > Setpoints > AUTO Setpoint > Reset SP to initial 
value).

6.3.4 Connect the AVR parallel with the grid
To connect parallel with the grid:

1. Select the necessary control mode (refer to Select a control 
mode on page 43).
• PF or VAR mode: select the parameter “Enable PF/VAR initial 

SP” (Setup menu > Setpoints > AUTO Setpoint > Enable 
PF/VAR initial SP).

• Other control modes: the setpoint of the active control 
mode stays the same.

2. Connect to the grid. Make sure that the digital input signal 
“Parallel with Grid Status” is active.

6.3.5 Disconnect the AVR from the grid
To disconnect from the grid:

1. If necessary, select the parameter “Loose grid go to initial SP” (Setup menu > Setpoints > 
AUTO Setpoint > Loose grid go to initial SP). When you disconnect from the grid, the 
active control mode changes to Auto mode with initial setpoint values.

2. Disconnect from the grid. Make sure that the digital input signal “Parallel with Grid 
Status” is not active.

3. The control mode changes to Auto mode. The voltage setpoint is adjusted to ensure that 
the machine voltage stays constant.

Control mode Final value
Manual Ie No load

Open Loop 100 % 1/Kceil

PF 1.0

VAR 0 %

Auto 100 %
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6.4 Select a control mode
To select a control mode:

1. Make sure that CMT 1000 has control access.

2. Open the Setup menu.

3. Select Digital I/Os.

4. Select the correct digital inputs to activate a control mode. For example, to activate PF 
mode, select PF Enable and, if necessary, select Gen CB Closed Status or Parallel with Grid 
Status. For more information on the generator states and priorities of the control modes, 
refer to Priority of control modes on page 40. 

0 = logical 0

1 = logical 1

X = not relevant

* with droop or compensation

Note! If a digital input is set continuously at logical 1, it is possible to invert it. 
The digital input is considered as occupied. Refer to Digital inputs on page 46.

5. If necessary, select a digital output signal Manual Active or PF VAR Active. If the green 
status indicator is on, the selected control mode is active.

6. Open the Tune menu of CMT 1000.

7. Select Setpoint Adjust.

8. Make sure that the correct control mode and generator status are selected in the 
Setpoint Adjust window (refer to Setpoint Adjust on page 69). If a menu item is shown as 
gray, it is not possible to activate it with the selected configuration.

Control 
mode

Digital inputs

Stand
by

SYN Gen CB 
Closed 
Status

Parallel 
with 
Grid 

Status

Manual 
Enable

Open 
Loop 

Enable

VDC 
Enable

PF 
Enable

Var 
Enable

Standby 1 X X X X X X X X

Sync 0 1 X X X X X X X

Manual 0 0 X X 1 X X X X

Open 
Loop

0 0 X X 0 1 X X X

VDC 0 0 1 0 0 0 1 X X

PF 0 0 1 1 0 0 0 1 X

VAR 0 0 1 1 0 0 0 0 1

Auto 0 0 0 X 0 0 X X X

* 0 0 1 X 0 0 0 0 0
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6.5 Software options
The device software of the AVRs in the UNITROL 1000 series is based on one source code. 
A set of software options is enabled by default in each AVR. It is possible to enable more 
software options that extend the capabilities of the AVR. 

To enable a software option, send a request for a password to your ABB representative.

For instructions on how to enable a software option, refer to Enable a software option on 
page 45.

6.5.1 Software packages
These are the software packages that you can select: 

• ECO

• LIGHT 

No. Software option Description Package type

1 AVR/FCR/PF/VAR AVR regulator modes ECO

2 Limiters Limiters ECO

3 Soft Start Soft Start ECO

4 Voltage Matching Voltage Matching ECO

5 History Logger Records the last two hours of 
operation

LIGHT

6 Modbus Modbus TCP for remote access LIGHT

7 Rotating Diode Monitoring Monitoring of rotating diodes 
on the exciter machine

LIGHT
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6.5.2 Enable a software option
Use CMT 1000 on your PC to enable software options in the AVR. 

Note! It is necessary to have a password for each additional software option. Send 
a request for a password to your ABB representative. For more information, refer 
to Support information on page 10.

To enable a software option:

1. Make sure that CMT 1000 has control access. 
Refer to Operators and access levels on page 
90.

2. In the main menu of CMT 1000, open the File 
menu.

3. Select SW-Options.

4. Write the password in the white box next to 
the software option that you want to enable. 
Press the Enter key on your keyboard.

5. Click the status button on the right.

6. Make sure that the status button next to the 
white box goes on. If the status button is off, 
make sure that you write the password 
correctly.

7. When all of the necessary software options 
are enabled and the status buttons are on, 
click the Save to EEPROM button.

8. In the main menu of CMT 1000, open the File 
menu.

9. Select Write parameters to EEPROM.

10. Start the AVR again.

11. Open the File menu.

12. Select SW-Options.

13. Make sure that the status button is on for the necessary software options. If a status 
button is off, do the procedure again.
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6.6 Digital inputs

Digital input signal Description

None Input not assigned

Excitation ON Excitation ON command active:
• Field Flashing starts, if Off Level > 0 %
• Auto mode: Soft Start starts after the Off Level is 

reached, and increases until the Initial setpoint value of 
Auto mode.

• Other control modes: Initial setpoint
• Refer to Initial setpoint on page 41
Excitation ON command not active:
• All setpoints are immediately set to their initial values 

and remain fixed there.

Gen CB Closed Status Gen CB Closed Status active:
• Activates current measurement
• The input signal triggers the ramp up of the Soft Start 

also if the hold time of Soft Start has not expired.
Gen CB Closed Status not active:
Refer to Setpoint with an open GCB on page 41.

Parallel with Grid Status Parallel with grid status active:
• With Gen CB Closed Status on, you can change between 

PF mode and VAR mode.
Connect the AVR parallel with the grid:
Refer to Connect the AVR parallel with the grid on page 42.
Disconnect the AVR from the grid:
Refer to Disconnect the AVR from the grid on page 42.

Increase Increases the setpoint of the active control mode

Decrease Decreases the setpoint of the active control mode

Reset Setpoint Reset Setpoint active:
Refer to Reset setpoint on page 42.

Remote SP Enable Remote SP Enable active:
• Enables the setpoint adjustment from an analog input
• The setpoint changes in accordance with the defined 

ramp rate to the selected value

Note! Set remote setpoints in the analog input 
section.

PF Enable Activates power factor regulation

Var Enable Activates reactive power regulation

Manual Enable Activates excitation current regulation
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Open Loop Enable Activates the direct control of a power transistor:
Overrides AVR output.

Synchronize Activates Voltage Matching:
(Requires the Synchronization software option)
The input signal activates Voltage Matching only.

Reset Alarm Clears the alarms that follow: 
• Supervision Alarm 1 and 2
• Supervision Trip
• Switch over
• Monitor Alarm 1 and 2

Standby Reserved

RC Fieldbus Block Disables the fieldbus communication in local operation:
• All control registers are set to default
• Excitation stops if it is controlled over Modbus

External Alarm External Alarm input:
Used to detect axillary contacts of the MCBs.

Emergency Excitation Off Emergency Excitation OFF command active:
Overrides Excitation ON input signal and Modbus control 
signal.

Droop2 Select Activates Kq2 (Droop) parameters

Unload VAR Regulates VAR to 0:
Command must be active until VAR is at 0.

Remote IO control Enables selection of the options that follow:
• True: “Fieldbus write all” enables the override of digital 

inputs over Modbus
• False: It is not possible to override digital inputs over 

Modbus

Excitation OFF Changes the behavior of Excitation ON / Excitation OFF 
to pulse logic
A pulse from a digital input or from the fieldbus can 
change the excitation status:
• Positive edge of the Excitation ON input signal starts 

the excitation
• If the Excitation OFF input signal is active, the excitation 

is stopped and blocked

Digital input signal Description
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6.7 Digital outputs

Digital output signal Description

None Output not assigned

Boost Boost status signal is active:
• Boost supports the excitation if there is a short-circuit 

current or heavy load in the network
• Boost is configured to trigger at a defined threshold of 

the machine voltage
• Boost is blocked during Field Flashing and Soft Start

Limiter Active 1 One of the selected limiters in the limiter matrix 
activates

Limiter Active 2 One of the selected limiters in the limiter matrix 
activates.

Field Flashing You can activate Field Flashing (voltage ramp up) only if 
Excitation ON is enabled.
You can start the next Field Flashing only after:
• The Excitation ON signal is on
• You stop and start the unit again (power on and off)
During Field Flashing the excitation output is blocked in all 
control modes. PWM is forced to 0 %.

Voltage Relay Voltage Relay:
• Active: The machine voltage is less than the boost 

threshold
• Not active: The machine voltage is more than the boost 

threshold plus hysteresis
Voltage Relay does not depend on the Excitation ON input 
signal.

Supervision Trip A trip indication that is triggered by monitor functions

Supervision Alarm 1 An alarm indication that is triggered by monitor 
functions

Supervision Alarm 2 An alarm indication that is triggered by monitor 
functions

Monitor Alarm 1 An alarm indication that is triggered by monitor 
functions

Monitor Alarm 2 An alarm indication that is triggered by monitor 
functions

Monitor Alarm 3 An alarm indication that is triggered by monitor 
functions
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6.8 Polarity and forcing digital signals
You can invert the polarity of each digital input and output port. Each DIO port can be set only 
as an input or output at a time.

Invert the polarity of DIO ports to force a digital signal.

6.8.1 Force digital input signals
You can set each digital input signal to a predefined value without terminal connections. This 
process is called forcing.

To force a digital input signal:

• When polarity is set to Normal, the digital input is set to not active 

• When polarity is set to Inverted, the digital input is set to active 

Note! Do not wire a digital input at the terminal, if you have forced the signal.

6.8.2 Force digital output signals
You can force each digital output signal for test purposes. To force the signal, invert the 
polarity. It is possible to force a signal also if there is no selected output signal.

Diode Alarm An alarm indication of an open diode
• Detection of an open diode on the rotor of the machine
• Depends on the settings for rotating diode monitoring

Diode Trip A trip indication of a shorted diode
• Detection of a short-circuit diode on the rotor of the 

machine
• Depends on the settings for rotating diode monitoring

FRT Detection An indication of a fault ride through
There is a sudden voltage dip on the network.

ExcON status An indication that the excitation is on
If the excitation is blocked internally, the signal is not 
active. Refer to Power over USB cable only on page 36.

Softstart Active An indication that Soft Start is active

Digital output signal Description

24 V DC

normal

DIO1 to 8
DI9 to 12
DI13 to 18

24 V DC

inverted

DIO1 to 8
DI9 to 12
DI13 to 18
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6.9 Analog inputs

Note! To set an external setpoint from the analog input list, you must also enable 
the digital input “Remote SP Enable”. Refer to Digital inputs on page 46.

Analog input signal Description

None Input not assigned

Auto Remote Setpoint 
±10 V / 0 - 20 mA

External setpoint to Auto mode

PF Remote Setpoint 
±10 V / 0 - 20 mA

External setpoint to PF mode

VAR Remote Setpoint 
±10 V / 0 - 20 mA

External setpoint to VAR mode

Manual Remote Setpoint 
±10 V / 0 - 20 mA

External setpoint to Manual mode

Open Loop Remote SP
±10 V / 0 - 20 mA

External setpoint to Open Loop mode

Common Remote SP
±10 V / 0 - 20 mA

Common remote setpoint for Auto, PF and VAR modes

UM Aux
±10 V / 0 - 20 mA

Additional signal to the summing point of the voltage 
regulator
Used to measure the transfer function of the excitation 
system.

VAR Aux Measurement
±10 V / 0 - 20 mA

Injection signal to the summing point of the PF and VAR 
regulator

Ie External Reserved for the real-time simulator

Digital Input 13(+) & 14(-) You can use analog inputs as digital inputs

Digital Input 15(+) & 16(-) You can use analog inputs as digital inputs

Digital Input 17(+) & 18(-) You can use analog inputs as digital inputs

Motor Speed Speed input for motor excitation
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6.9.1 Voltage level of the analog inputs
You can set a minimum and maximum voltage level for each analog input.

6.9.1.1 Input voltage of an external setpoint

Analog input signal

Uin0%
Minimum 

input voltage
(-10 - +10 V)

Uin100%
Maximum 

input voltage 
(-10 - +10 V)

Remarks

Auto Remote Setpoint Auto setpoint 
min

Auto setpoint 
max

Refer to Input voltage of 
an external setpoint 
on page 51.

PF Remote Setpoint PF setpoint min PF setpoint max

VAR Remote Setpoint VAR setpoint 
min

VAR setpoint 
max

Manual Remote Setpoint Manual setpoint 
min

Manual setpoint 
max

Open Loop Remote SP Open Loop 
setpoint min

Open Loop 
setpoint max

UM Aux UM Aux min UM Aux max Range:
-100 % to +100 %
Refer to Input voltage to 
the summing point 
on page 52.

VAR Aux Measurement -10 % +10 % Range:
-10 % to +10 %

Digital Input 13(+) & 14(-) Set to 2.0 V Set to 5.0 V Refer to Requirements 
for DI13 to DI18 on page 
52Digital Input 15(+) & 16(-) Set to 2.0 V Set to 5.0 V

Digital Input 17(+) & 18(-) Set to 2.0 V Set to 5.0 V

Uin0%
[V]

Uin100%

Internal signal value [%]

Setpoint max

10

Setpoint min

-10

Ext. Setpoint Auto
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6.9.1.2 Input voltage to the summing point

6.9.1.3 Requirements for DI13 to DI18

Requirements for analog inputs that are used as digital inputs (DI13 to DI18):

Note! Analog and digital inputs must not be active at the same time. If they are 
active at the same time, DI13 and DI14 are at logical 0.

6.10 Double Channel (DCH) software
Double Channel (DCH) is a software option that integrates supervision or monitor functions 
and redundant channel support for double channel systems. A double channel system has a 
main channel and a redundant channel.

Double Channel software is also used for single channel systems in order to force the system 
into Manual mode or to trip excitation.

For more information, refer to Control SW manual (3BHS399489 E02).

6.11 Remote access with Modbus
Remote access is a feature that allows monitoring and control of the AVR with the Modbus 
protocol. You can use remote access for applications that require a custom user interface or 
control from a remote location (for example, offshore).

A remote terminal that is set as the Modbus master can get access to an AVR through an 
Ethernet TCP/IP connection. Up to 10 Modbus masters in parallel can communicate with one 
AVR to read and write registers (measurements, setpoints and other information) from the 
AVR. For more information, refer to the Modbus Reference Manual (3BHS358281 E80) and 
Modbus Address Table (3BHS358281 E81).

To communicate with the AVR, the remote terminal must get a determined access level in the 
AVR in accordance with the necessary operation. Monitor access is used for read-only 
information. Control access is used to read and write registers. For more information, refer 
to Operators and access levels on page 90.

The electrical connections are described in Communication ports on page 36.

Uin0%

[V]
Uin100%

UM Aux [%]

 max

10
 min

10

-10

-10

Analog in

Uin

DI13 = 1

DI14 = 1

[V]2.0 5.0

-2.0-5.0
DI14 = 0

DI13 = 0

DI13(+) 0

DI14(-) 1

DI13(+) 1

DI14(-) 0
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Cyber security note: Modbus does not natively guarantee secure communication. 
Any node that is able to communicate with the AVR via Modbus can perform 
unwanted changes or incorrect configurations on such products that can disrupt 
the intended operation of the AVR and the systems connected to it. It is 
recommended to limit the Modbus communication within trusted networks and to 
strictly control access to such networks.

6.11.1 Configuration
Communication between a Modbus master (external device) and Modbus slave (the AVR) is 
based on the Modbus Slave-ID value. The Modbus Slave-ID value can be a value between 1 and 
247, where 247 is the default value.

There is a restriction, if the Modbus Slave-ID value is between 1 and 63 (except 32) and it is the 
same value as the AVR-ID number for the main channel or AVR-ID number +32 for the 
redundant channel.

In these situations, the AVR changes the Modbus Slave-ID value to 247 upon restart. You can 
set the Modbus Slave-ID for remote access between 64 and 247 without restrictions. This is 
the range that is recommended for most applications.

When you use CMT 1000 directly through an Ethernet connection, the Modbus Slave-ID is a 
value between 1 and 63. The value depends on the AVR-ID and the channel identification (Main 
or Redundant), also without the double channel software. When you set parameters with the 
CMT 1000, you can see the Modbus Slave-ID for CMT 1000 connection in the Modbus 
Supervision window. 

Note! Do not use the Modbus Slave-ID value for a direct CMT 1000 connection as 
the Modbus Slave-ID for remote access.

6.11.2 Ethernet TCP/IP connections to an AVR
• 1 CMT 1000 connection is possible

• 10 remote access connections are possible

Open the TCP ports that follow:

• Port 5002 (outbound) / 5003 (inbound):

• Device detection

• Ethernet scanning

• Port 502 (inbound): Modbus TCP



 

54

7. Commissioning and maintenance tool 
CMT 1000

This chapter gives information on the commissioning and maintenance tool CMT 1000. 
CMT 1000 is a PC application to adjust the settings of your AVR. Connect your PC to the AVR 
with a USB or Etherner connection. ABB recommends a USB connection for the initial 
installation and an Ethernet connection for control use.

For the connection options, refer to Communication ports on page 36 and Modbus Reference 
Manual (3BHS358281 E80).

7.1 Basic features of CMT 1000
With CMT 1000 you can:

• Set parameters and I/O signals

• Adjust setpoint steps

• Monitor and control measurements

• Visualize measurements with an oscilloscope

• Upload and download parameter files

• Do commissioning and PID tuning

7.2 System requirements
The minimum system requirements for the PC:

• Microsoft® Windows operating system

• A Pentium 1 GHz processor or higher

• 512 MB RAM

• 10 GB of free hard disk space

• A display resolution of 1024x768 pixels or more

7.3 Installation procedure
Obey the installation procedure:

1. Download the latest documentation and software from the myABB business portal. Refer 
to Documentation, software and tools on page 8 for instructions.

2. Install the CMT 1000 software (refer to Install CMT 1000 on page 55).

3. If problems occur, refer to Problems with installation on page 55.

4. When you complete the installation procedure, refer to Starting procedure on page 56.
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7.3.1 Install CMT 1000
To install the CMT 1000 software:

1. Make sure that you have the correct revision of the CMT 1000 software (3BHS346676). 
Note that you can open parameter files only with a compatible software revision.

2. Unzip and open the software folder on your PC.

3. Double-click setup.exe to install the CMT 1000 software.

4. Follow the instructions in the installer window.

5. Start the PC again when the CMT 1000 installer tells you to restart. Select Restart in the 
installer window.

6. Connect the USB cable between the AVR and your PC. Use only the supplied red USB cable.

7. Open the Device Manager of your PC to make sure that the AVR is listed under Ports.

8. If problems occur, refer to Problems with installation on page 55.

7.3.2 Problems with installation
7.3.2.1 USB driver installation

If problems occur with the USB port, install the USB driver:

1. Download CMT1000 USB Driver (3BHS346676) from the myABB business portal.

2. Open the software folder on your PC.

3. Double-click InstallUSBdriver.exe to install the USB driver.

4. Connect the AVR with the USB cable to your PC. Use only the supplied USB cable.

5. A message “New Hardware Found” shows on your PC. 

6. Click Next until the installation is completed.

7.3.2.2 Changing the firewall settings

If problems occur with the firewall settings, change the firewall settings of your PC:

1. In the main window of your PC, click Start/Window > Settings > Network & Internet > 
Windows Firewall > Allow an app or feature through Windows Firewall.

2. Select the Exceptions tab.

3. Select Add Port.

4. Enter the Name Scanning and Port number 5002.

5. Select OK to save the changes.

6. Do the same procedure for port 5003.

Note! Speak to your IT department representative, if you are not allowed to change 
the firewall settings of your PC.
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7.4 Starting procedure
It is necessary to set a connection type before communication with the AVR is possible.

Follow the starting procedure:

1. Set a connection type (refer to Set a connection type on page 56).

2. After you have a connection with the AVR, a scanning process starts. Refer to Scanning 
process on page 57.

3. If problems occur, refer to Failure of the scanning process on page 57.

4. After the scanning process completes, you can start the communication with the AVR. 
Refer to Communication with the AVR on page 58.

7.4.1 Set a connection type
To set a connection type:

1. In the main window of CMT 1000, open the Communication menu.

2. Select Port Configuration.

3. Select a connection type:

• Select the Serial tab for a connection through the USB port. Refer to Connection 
through the USB port on page 56.

• Select the TCP/IP tab for a connection through the Ethernet port. Refer to Connection 
through the Ethernet port on page 57.

Note! It is recommended to use the USB connection for the installation procedure. 
If possible, use the Ethernet connection for operation.

7.4.1.1 Connection through the USB port

1. Select the Serial tab.

2. In the Available Communication Ports menu, select 
the applicable communication port.

3. Select OK to save the changes or Cancel to abort the 
changes.

If you cannot find the applicable communication port 
(COMx):

• Examine if the configuration of the communication 
port is correct in the operating system of your PC. 

• Examine if another application uses the same 
communication port. 

• Typical settings for a communication port:

• Base I/O Port address: 3f8

• Interrupt Request Line (IRQ): 4
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7.4.1.2 Connection through the Ethernet port

1. Select the TCP/IP tab.

2. Enter the IP address of the remote terminal in the 
Remote IP Address field.

3. A pinging process starts automatically. After two 
seconds CMT 1000 shows a message:

• If the message “Connection OK” is shown, you 
can connect the remote terminal to the AVR. 

• If the message “Not accessible” is shown, the 
connection is not satisfactory. Examine if the 
configuration and installation of the Ethernet, 
gateway, firewall and cabling are correct. For 
configuration, refer to Communication ports on 
page 36.

The pinging process operates at intervals of two 
seconds after the last message is displayed.

4. Click Blink LED to flash the LED on the connected AVR. Make sure that you are connected 
to the correct AVR.

5. Select OK to save the changes or Cancel to abort the changes.

Note! If CMT 1000 shows a message “In use”, CMT 1000 uses the IP address. You 
can ignore this message.

7.4.2 Scanning process
After you set a connection type, CMT 1000 starts a scanning process. CMT 1000 senses an 
AVR through the related communication port (USB or Ethernet). During the scanning process 
(some seconds) it is not possible to change the access level.

When CMT 1000 senses an AVR, it shows the AVR-ID and channel identification (Main or 
Redundant) in the main window.

If CMT 1000 does not sense an AVR, refer to Failure of the scanning process on page 57.

7.4.3 Failure of the scanning process
If CMT 1000 does not sense an AVR in one minute, the main window shows a message Link 
Not Found. The scanning process continues in the background.

Make sure that the port settings and the hardware connections are correct. Refer to USB port 
on page 36 or Ethernet port on page 37.
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7.5 Communication with the AVR
CMT 1000 has three access levels to connect to an AVR: off-line, monitor access and control 
access. 

You can communicate with the AVR only during monitor access or control access. When off-
line, CMT 1000 can only read the AVR-ID and channel identification (Main or Redundant) 
directly from the AVR. 

For more information, refer to Operators and access levels on page 90.

To communicate with the AVR:

• Change the access level (refer to Access selector on page 58)

• Control the parameter changes (refer to EEPROM status indicator on page 59)

Note! Make sure to examine the access selector and EEPROM status indicator 
before you upload and download parameter files. Refer to Parameter files on page 
73.

7.5.1 Access selector
You can change the access level with the access selector. The color of the access selector 
changes between green and yellow:

No. Description
1 Green:

• The AVR is fully 
operational 

• CMT 1000 is off-line
• Or you use CMT 1000 

without a connection to 
an AVR

2 Yellow:
The AVR is only powered 
with the supplied red USB 
cable, excitation is blocked

1

2
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7.5.2 EEPROM status indicator
The EEPROM status indicator shows if the parameter values agree in the RAM and in the non-
volatile memory (EEPROM) of the AVR. The color of the EEPROM status indicator changes (on 
and off):

Make sure that you save the changed parameter values to the non-volatile memory (EEPROM) 
of the AVR. For instructions, refer to Write parameters to the non-volatile memory (EEPROM) 
of the AVR on page 75. If the changed parameter values are not saved, the data is lost when 
you start the AVR again.

Note! The EEPROM status indicator is shown in the main window only during 
monitor access or control access.

No. Description
1 ON: 

All parameter values agree

2 OFF:
A minimum of one 
parameter is changed

1

2
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7.6 Menu structure
The main window of CMT 1000 has 6 menus, where you can get access to all of the software 
features. Each menu item is in a group in accordance to its functionality.

Overview of the menus:

• File menu: Open or save parameter files and enable software options

• Monitor menu: Online measurements

• Setup menu: Set parameters

• Communication menu: Set IDs / Ports / Modbus

• Tune menu: Tune regulators

• Help menu: Software information

Note! To close the windows, click the cross button in the top-right corner of the 
window. If there is no cross button, the information in the window tells you how to 
close the window.

Note! If some menu items are shown in gray, they are not available in the AVR or 
you need to change the access level to control access.

7.6.1 File menu
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File menu items:

• Open Parameter File: Open a parameter file from the hard disk of the PC

• Save Parameter File: Save a parameter file to the hard disk of the PC

• Write Parameters to EEPROM: Save the parameters to the non-volatile memory (EEPROM) 
of the AVR

• Customer setup: Use a custom application

• SW-Options: Enable software options

• Close: Close the CMT 1000 application

Refer to Parameter files on page 73 for instructions on how to use parameter files.

Refer to Use a customer setup on page 72 for more information on custom applications.

Refer to Enable a software option on page 45 for more information on software options.

7.6.2 Monitor menu

Monitor menu items:

• Measurements: Online measurements (Main channel)

• Oscilloscope: Online measurements

• PQ Diagram: Online measurements

• Sync Diagram: Online measurements for Synchronization

• Temp Influence: Temperature influence visualization for machine and excitation current

• Second Channel Measurements: Online measurements from the second channel 
(Redundant channel in a double channel system)

• Data Logger: Data log viewer

• Event Monitor: Event viewer

• History Logger: History log viewer
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7.6.2.1 Measurements

The Measurements window shows the measurements of the AVR.

7.6.2.2 Oscilloscope

The Oscilloscope window shows a visualization of 6 signals at a time (out of 21 signals). For 
more information, refer to Oscilloscope on page 79.
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7.6.2.3 PQ Diagram (Power chart)

The PQ Diagram window shows the measurements of reactive power Q (on the x-axis) and 
active power P (on the y-axis) in relation to the machine voltage. 

The white arrow (at the bottom of the figure) shows the current operating point when the 
synchronous machine is connected to the grid. When the synchronous machine is idle, the 
arrow is at 0, because there is no active or reactive power.

7.6.2.4 Synchronization Diagram, Synchroscope

The Sync Diagram window shows the measurements of the differential voltage machine to 
network (UM - UNET [%]) and Slip (fNET - fM [Hz]). Synchronization software is required.

For more information, refer to the UNITROL 1000 Com-Instructions and PID tuning 
(3BHS399489 E01).
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7.6.2.5 IM and Ie Temperature Monitor

The IM Temperature Monitor and Ie Temperature Monitor windows show the measurements 
of machine current (IM) and excitation current (Ie) in relation to the cooling temperature.

7.6.2.6 Second Channel Measurements

The Second Channel Measurements window shows the measurements from the second 
channel (Redundant) in a Double Channel system. Double Channel (DCH) software required. 

For more information, refer to Double Channel (DCH) software on page 52 and Control SW 
manual (3BHS399489 E02).
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7.6.2.7 History Logger

The History Logger window shows visualization of history logs from the AVR.

For more information, refer to History Logger on page 86.

7.6.3 Setup menu
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Setup menu items:

• System Data: Set parameters for system data

• Soft Start: Set parameters for Soft Start ramp

• Field Flashing: Settings for Field Flashing

• Motor Excitation: Settings for Motor Excitation

• Limiters: Settings for limiters

• Setpoints: Settings for setpoints

• Voltage Droop Compensation: Settings for VDC software

• Digital I/Os: Set digital inputs and outputs

• Analog inputs: Set analog inputs

• Analog outputs: Set analog outputs

• Synchronization: Set parameters for synchronization

• Diode Monitoring: Settings for Rotating Diode Monitoring

• PSS: Set parameters for Power System Stabilizer

• Monitor and Protection: Settings for monitor and supervision functions

• AVR Time and Date: Set the time and date of the AVR

• Data Logger: Settings for Data Logger

For more information on the device software, refer to Device software on page 38 and 
Control SW manual (3BHS399489 E02).

Note! When CMT 1000 is off-line you can see also software options that are not 
available in your AVR.

7.6.3.1 Setup > Limiters menu
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Limiters menu items:

• V/Hz Limiter: Configuration of V/Hz limiter

• Operational Limits: Configuration of PQ, UM, IM and Ie limiters

• Boost and FRT detection: Line short-circuit support and fault ride through

• Temp Influence: IM and Ie limiters temperature influence

7.6.3.2 Setup > Setpoints menu

Setpoints menu items:

• Auto: Set the setpoints for Auto mode

• PF: Set the setpoints for PF mode

• Var: Set the setpoints for VAR mode

• Manual: Set the setpoints for Manual mode

• Open Loop: Set the setpoints for Open Loop mode
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7.6.4 Communication menu

Communication menu items:

• ID Definition: Set the AVR-ID (for VDC) and the channel identification (for DCH)

• Port Configuration: Configuration of a serial COM port or TCP/IP address

• AVR Ethernet Settings: Settings for the Ethernet communication

• Modbus Supervision: Set Modbus for remote access

• VDC Monitor: Monitoring tool for VDC

• Control Password: Protection against change of parameters

For instructions on the starting procedure and configuration of the AVR, refer to Starting 
procedure on page 56 and Set the AVR-ID and channel identification on page 71.

For information on the Modbus protocols, refer to the Modbus Reference Manual 
(3BHS358281 E80).

For password protection, refer to Set a control password on page 72.

7.6.5 Tune menu

Tune menu includes:

• Setpoint Adjust: Generator states, control modes, alarm and limiter statuses, setpoints 
and steps

• Auto: Parameters for Auto mode (PID) and Kq Droop

• PF/Var/PQ Limiter: Parameters for PF mode, VAR mode and PQ limiter (PI)

• Manual/Ie Limiter: Parameters for Manual mode (PI) and Ie limiter

• AVR Tuning Assistant: Instrument for commissioning

• PSS Tuning Assistant: Power System Stabilizer
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7.6.5.1 Setpoint Adjust

The Setpoint Adjust window includes a visualization of the control modes, generator states, 
limiters and alarm status. Here you can adjust setpoints and do step response tests.

Note! It is recommended to keep the Setpoint Adjust window always open.

1. Generator State shows if the synchronous machine is connected to the grid, a secondary 
network, a primary network or if it has no load.

2. Active Mode shows the active control mode of the AVR in green.
Some control modes can be gray (disabled) if:

• A software option is not available 

• System conditions are not correct

• A signal is not set correctly

3. Limiter State shows the active limiters in the system.

4. Alarms shows the active alarms in the system. An alarm status is not shown if the related 
software option is not available in the AVR. 

5. Setpoint shows the setpoint of the control mode that is active. 

• You can adjust the setpoint with the DOWN and UP buttons. Note that you can adjust 
the setpoint also with analog or digital inputs (“Decrease” and “Increase” signals).

• You can apply a step to increase or decrease the setpoint of the active control mode. 
Enter a step value at UM Step and click the DOWN or UP button. Adjust the step with 
Step Length.

54321
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7.6.6 Help menu
In the Help menu you can update the device software of the AVR and get information on the 
software revisions.

Help menu items:

• Firmware update: Update the device software

• About CMT 1000: Information on the software revisions of the DSP, MCU and CMT 1000

7.6.6.1 Update the device software

Note! You can update the device software with a USB or Ethernet connection 
between the AVR and CMT 1000. Ethernet connection is faster.

To update the device software:

1. Download the correct software revision from 
the myABB business portal. For instructions, 
refer to Documentation, software and tools 
on page 8.

2. Make sure that CMT 1000 has control access.

3. Open the Help menu.

4. Select Firmware update.

5. Click Load File and select the correct file on 
your PC.

6. A new window opens. Click Update.

7. A new window opens. Click Continue.

8. The update process is completed in 
approximately 3 minutes.

9. After the update is completed (at 100 %), 
disconnect the USB cable or Ethernet cable. 
Disconnect and connect the power supply to 
the AVR.

10. Connect CMT 1000 with a USB cable or 
Ethernet cable to the AVR again.

11. Make sure that the new revision of the device software and CMT 1000 are compatible.

CAUTION

Prepare a backup file of the parameters before you update the device software.
For instructions, refer to Upload a parameter file to your PC on page 75.
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If problems occur:

1. Click Continue to close the update windows.

2. Disconnect the USB cable or Ethernet cable. Reconnect the cable after 5 seconds.

3. Select Control access in the main window of CMT 1000.

4. Do the update procedure again.

7.6.6.2 About CMT 1000

In the About CMT 1000 window you can see:

• AVR S/N: Serial number of the AVR

• Control: Software revision of the measurement and control unit (DSP) of the AVR

• MCU: Software revision of the micro-controller unit (MCU) of the AVR

• SW Revision: Software revision of CMT 1000

• Configuration: ABB or Custom application

Click on the window to close it.

Note! The serial number of the AVR is shown in the About CMT 1000 window. Please 
give the serial number to the ABB representative when you make requests for 
software options.

7.7 Additional tools
You can use additional tools to read parameter files and IEEE Comtrade files:

7.8 Set the AVR-ID and channel identification
To identify the AVR:

1. Open the Communication menu.

2. Select ID Definition.

3. Enter a number between 1 to 31 as an AVR-ID.

4. Select the channel identification: Main or Redundant.

Set an AVR-ID for each AVR. Each AVR must have a unique 
AVR-ID that identifies the AVR in a (serial) bus. However, in 
a double channel system the AVR-ID of the two AVRs must be identical.

Channel identification is Main by default. In a double channel system the channel 
identification must be Main for Channel 1 and Redundant for Channel 2. The main window of 
CMT 1000 shows the channel identification even if the Double Channel software is not 
available in the AVR.

Software tool Description URL
Notepad++ To compare parameter files 

and indicate differences.
http://notepad-plus-plus.org

TOP To read IEEE Comtrade files 
and to do overlays.

http://www.pqsoft.com/top/
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If you do not use the Double Channel software, you can change the channel identification 
without an effect on the AVR. However, a change of the channel identification has an effect 
on the Modbus ID that is used for remote access with CMT 1000. The Modbus slave ID that is 
used for remote access with CMT 1000 is a number between 1 and 63. The number depends 
on the AVR-ID and the channel identification (Main or Redundant). For more information on 
Modbus protocol, refer to the Modbus Reference Manual (3BHS358281 E80).

7.9 Set a control password
You can use a control password to protect against parameter changes by unauthorized 
persons. If you use a control password, you must enter it every time to get control access 
with CMT 1000. The control password activates control access for 10 minutes.

To set a control password:

1. Make sure that CMT 1000 has control access.

2. Open the Communication menu.

3. Select Control Password.

4. Enter a 4-digit code in the range of 0001 to 9999.

Settings for a control password:

• 0000 No password is active (default)

• 4783 Default password, independent of any setting

Note! The control password is used only to protect against parameter changes. Use 
the control password to prevent control access (write access) to the AVR. The 
control password does not deny access to the AVR by other connected Modbus 
masters. 

7.10 Use a customer setup
It is possible to use the AVR with a user-defined application (OEM customers). Customer 
setups are protected with a password. Customer setup requires a user name and a password. 

To enable a customer setup:

1. Open the File menu.

2. Enter your user name and password.

3. Select OK.

Note! Use the customer setup when CMT 1000 is offline to create and change 
parameter files. When CMT 1000 is connected to an AVR, you can see all of the 
parameters depending on the device setup.
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7.11 Parameter files
A parameter file contains the parameter values of the AVR. You can examine a parameter file 
in CMT 1000 or in a text editor. Engineering personnel can prepare a parameter file that 
contains a set of parameter values for the commissioning of an AVR.

Make sure that you understand the effect of the access levels on parameter files. For more 
information, refer to Access level statuses on page 90.

An example of a parameter file (an INI file):

You can:

• Examine a parameter file (on page 74)

• Edit a parameter file (on page 74)

• Download a parameter file to the AVR 
(on page 74)

• Write parameters to the non-volatile memory 
(EEPROM) of the AVR (on page 75)

• Upload a parameter file to your PC 
(on page 75)

• Prepare a configuration file for 
commissioning (on page 76)

If problems occur, refer to Problems with a 
parameter file on page 76.

CAUTION

• Be careful if you examine a parameter file in a text editor.

• Edit a parameter file only in CMT 1000.

• Do not use a parameter file that has incorrect changes. Incorrect parameter 
settings can cause damage to the AVR.



COMMISSIONING AND MAINTENANCE TOOL CMT 1000 

74

7.11.1 Examine a parameter file
To examine a parameter file in CMT 1000:

1. Make sure that CMT 1000 is offline.

2. Open the File menu.

3. Select Open Parameter File. The parameter file opens only in CMT 1000. It does not have 
an effect on the AVR.

4. You can examine the parameter values in the instruments of CMT 1000.

5. If necessary, change the parameter values in CMT 1000.

To examine a parameter file in a text editor:

1. Open a text editor.

2. Select a parameter file on your PC.

3. You can examine the parameter values in the parameter file.

4. Make sure that you do not change any parameters.

7.11.2 Edit a parameter file
To edit a parameter file:

1. Make sure that CMT 1000 is offline.

2. Open the File menu.

3. Select Open Parameter File. The parameter file opens only in CMT 1000. It does not have 
an effect on the AVR.

4. Edit the parameters in the necessary instruments of CMT 1000.

5. Select Save Parameter File in the File menu.

6. Enter a name for the parameter file.

7. Select a location on your PC.

8. The parameter file is stored on your PC.

7.11.3 Download a parameter file to the AVR
To download a parameter file to the AVR:

1. Make sure that CMT 1000 has control access.

2. Open the File menu.

3. Select Open Parameter File.

• The parameter file opens in the RAM of the AVR.

• Note that this procedure overrides the old parameter file in the RAM.

4. Examine the parameter values in CMT 1000 to make sure that the data is correct.

5. If you want to save the parameter values permanently in the non-volatile memory 
(EEPROM) of the AVR, refer to Write parameters to the non-volatile memory (EEPROM) of 
the AVR on page 75.

6. If you do not want to save the new parameter values, restart the AVR. The AVR starts next 
time (power cycle on the control supply) with the previous parameter values.
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7.11.4 Write parameters to the non-volatile memory (EEPROM) 
of the AVR

To save the parameters on the non-volatile memory (EEPROM) of the AVR:

1. Make sure that CMT 1000 has control access. All parameters are read directly from the 
AVR.

2. Open the File menu.

3. Select Write Parameters to EEPROM.

4. Make sure that the EEPROM status indicator in the main window of CMT 1000 is ON (refer 
to EEPROM status indicator on page 59).

5. If the EEPROM status indicator is ON, the parameter values are saved in the AVR.

6. If the EEPROM status indicator is OFF, do the procedure again.

7.11.5 Upload a parameter file to your PC
Note! If it is necessary to replace an AVR with a spare unit, prepare a backup file. 
Save all of the used parameter values in a parameter file.

To upload a parameter file to your PC:

1. Make sure that CMT 1000 has the necessary access level:

• Monitor or control access to read the parameters directly from the AVR.

• Off-line to save a new parameter file with data from CMT 1000 only.

2. Open the File menu.

3. Select Save Parameter File.

4. Enter a name for the parameter file.

5. Select a location on your PC.

6. The parameter file is stored on your PC.

CAUTION

Save the parameters to the non-volatile memory (EEPROM) of the AVR each time 
you adjust the parameter values. If the parameters are not saved to the EEPROM, 
after a power cycle the AVR starts with the previous values.
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7.11.6 Prepare a configuration file
You can use a parameter file called “a configuration file” as a reference parameter file for the 
commissioning of one or more AVRs.

To create a configuration file:

1. Make sure that CMT 1000 is offline and not connected to an AVR.

2. Make sure that you do not have a parameter file open in CMT 1000.

3. Do the necessary changes to the parameter values.

4. Open the File menu.

5. Select Save Parameter File.

6. Enter a name for the parameter file.

7. Select a location on your PC.

The configuration file is stored on your PC. The configuration file includes the selected 
parameter values for one or more AVRs.

7.11.7 Problems with a parameter file

Parameter files must be compatible and created with the same CMT 1000 revision that you 
use. A warning message occurs if:

• A parameter file is not compatible with your CMT 1000 release.

• A parameter value is out of the permitted range of selection.

• A software option is marked as activated in the parameter file, but it is not available in 
the AVR.

• The warning message shows a list of the software options that are marked as 
activated in the parameter file, but that are not available in the AVR. 

• The software options are activated in the AVR only when you enable them in 
CMT 1000. Refer to Enable a software option on page 45 for more information.

CAUTION

CMT 1000 gives a warning message if it is not possible to download a parameter 
file to the AVR. It is the responsibility of the user to make sure that all of the 
parameters are set correctly before operating the AVR.
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7.12 Adjust digital I/Os
You can:

• Set digital inputs DIO1 to DIO8 as input and output at the same time.

• Use digital inputs DI13 to DI18 as virtual digital inputs. They are not set as digital inputs in 
the analog inputs section. 

• Set analog inputs as digital inputs (DI13 to DI18). Refer to Set an analog input as a digital 
input on page 78.

Note! When you use analog inputs for digital input signals, make sure that both 
signals are not active at the same time. 

Note! The digital input with the highest number overrides digital inputs with a 
lower number. You can set an input signal two times to enable a function, such as 
“Excitation ON” during commissioning. For more information, refer to the UNITROL 
1000 Comm-Instruction and PID Tuning (3BHS399489 E01).

To adjust the digital I/Os:

1. Make sure that CMT 1000 has the 
necessary access level:

• Control access to adjust the current 
parameters in the AVR

• Off-line to prepare a new 
parameter file

2. Open the Setup menu of CMT 1000.

3. Select Digital I/Os.

4. Select a digital I/O between DIO1 and 
DI12. For instructions on digital inputs 
from DI13 to DI18, refer to Set an analog 
input as a digital input on page 78.

5. If necessary, select a direction: Input or 
Output. You can select a direction for 
the inputs DIO1 to DIO8.

6. Click the white box to open the menu of 
digital inputs and outputs.

7. Select a signal.

8. Select polarity: Normal or Inverted. 
Refer to Polarity and forcing digital 
signals on page 49.

9. The status indicator on the right shows:

• ON: the signal is logical 1

• OFF: the signal is logical 0

10. Save the parameter changes:

• To the AVR (refer to Write parameters to the non-volatile memory (EEPROM) of 
the AVR on page 75)

• To your PC (refer to Upload a parameter file to your PC on page 75)
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7.12.1 Set an analog input as a digital input
You can set analog inputs as digital inputs to enable the digital inputs DI13-DI18.

To set an analog input as a digital input:

1. Make sure that CMT 1000 has the necessary access level:

• Control access to adjust the current parameters in the AVR

• Offline to prepare a new parameter file

2. Open the Setup menu of CMT 1000.

3. Select Analog Inputs.

4. Select an analog input: AI1, AI2 or AI3. 

5. Click the gray box to open the menu of 
digital inputs.

6. Select a signal. For example, to enable 
the digital inputs DI13 and DI14, select 
Digital Input 13(+) & 14(-).

7. Adjust the input range:
Uin 0 % = 2.0 V

Uin 100 % = 5.0 V

8. Open the Setup menu of CMT 1000.

9. Select Digital I/Os.

10. Select the necessary signals for the 
digital inputs DI13-DI18. Click 
the white box to open the menu 
of digital inputs.

11. Select polarity: Normal or Inverted. Refer to Polarity and forcing digital signals on page 
49.

12. The status indicator on the right shows:

• ON: the signal is logical 1

• OFF: the signal is logical 0

13. Save the parameter changes:

• To the AVR (refer to Write parameters to the non-volatile memory (EEPROM) of 
the AVR on page 75)

• To your PC (refer to Upload a parameter file to your PC on page 75)
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7.13 Oscilloscope
The Oscilloscope visualizes 6 signals at a time (out of 21 signals in the signal menu). You can 
examine real-time measurements and saved transient data. 

You can:

• Set signals for visualization (on page 80)

• Adjust the buffer length (on page 80)

• Save a setup (on page 81) or use a saved setup (on page 81)

• Record operation of the AVR (on page 81)

• Save a waveform file (on page 82) and open a saved waveform file (on page 82)

• Examine a saved waveform file and use a sweep buffer (on page 82)

If problems occur, refer to Problems with the Oscilloscope on page 85.

1
2 3

5

7
6

4

1

2 3

8
6

No. Description
1 Color-coded signals

2 Cursor A

3 Cursor B

4 Signal menu

5 Buffer length

6 Zoom bar

7 Scaling

8 Offset

Note! For a description of the analog signals 
shown in the Oscilloscope, refer to Analog 
status signals on page 84.
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Oscilloscope menu items:

When you use the Oscilloscope, it is recommended to have these windows open:

• Measurements

• Setpoint Adjust

• Monitor and Protection

• Digital I/Os

• Applicable instruments, such as PQ Diagram and Tune windows

7.13.1 Set the signals
To set a signal in the Oscilloscope:

1. Open the Monitor menu in the main window of CMT 1000.

2. Select Oscilloscope.

3. On the right side of the Oscilloscope window, you can set a signal for each of the 6 color-
coded sections.

4. Click the arrow down next to the signal to open the signal menu.

5. Select a signal from the signal menu.

6. You can save the setup to use the same settings later (refer to Save a setup on page 81).

7.13.2 Adjust the buffer length
You can adjust the buffer length of the Oscilloscope to examine and record data on a specific 
time frame.

To adjust the buffer length:

1. If necessary, make sure to save the data on the Oscilloscope before you change the buffer 
length (refer to Save a waveform file on page 82).

Note! After the transient data goes through the buffer length, you cannot save the 
data anymore.
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2. In the bottom of the Oscilloscope window, select the box next to Buffer Length.

3. To change the value, select the arrow down or up. You can select a predefined value: 1, 2, 
5, 10, 20, 50, 100, 200 or 500 seconds.

4. After you select a new value, the Oscilloscope window changes.

5. If necessary, use the zoom bar to see a bigger or smaller area of the signal. The zoom bar 
does not have an effect on the buffer length.

7.13.3 Save a setup
To save the settings of the Oscilloscope:

1. Make sure that CMT 1000 has monitor or control access.

2. Make sure you have the correct signals and buffer length.

3. Open the File menu of the Oscilloscope.

4. Select Save Setup.

5. Enter a name for the setup file (a file with a *.cfg suffix).

6. Select a location on your PC.

7. You can use the setup file to record operation later, or on another AVR.

7.13.4 Use a saved setup
To use a saved setup:

1. Open the File menu of the Oscilloscope.

2. Select Recall Setup.

3. Select the correct setup file (a file with a *.cfg suffix) on your PC.

4. The Oscilloscope uses the saved setup.

7.13.5 Record AVR operation
To record the operation of the AVR:

1. Make sure that CMT 1000 has monitor or control access.

2. Select 6 signals of the 21 options.

3. Make sure that the buffer length is correct.

4. Click Start to record.

5. Click Freeze Waveform to stop recording.

6. You can save the waveform file on your PC (refer to Save a waveform file on page 82).

Note! The menu items Start and Freeze Waveform change their names after you 
select it.
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7.13.6 Save a waveform file
To save a waveform file:

1. In the Oscilloscope window, open the File menu.

2. Select Save Waveform.

3. Select a location on your PC.

4. Enter a file name.

5. The saved waveform file has a *.cwf suffix.

7.13.7 Open a saved waveform file

To open a saved waveform file from your PC:

1. In the Oscilloscope window, open the File menu.

2. Select Open Waveform.

3. Find the location on your PC.

4. Select the waveform file. The waveform file opens in the Oscilloscope.

5. If necessary, adjust the buffer length to see the full transient data (refer to Adjust the 
buffer length on page 80).

6. To examine the saved waveform file, refer to Examine a waveform file on page 82.

7.13.8 Examine a waveform file
You can:

• Use the cursors A and B (refer to Use the cursors on page 82)

• Examine a saved waveform file (refer to Examine a saved waveform file on page 83)

• Use a sweep buffer (refer to Use a sweep buffer on page 83)

7.13.8.1 Use the cursors

To use the cursors:

1. Make sure that the cursors are enabled (Edit > Cursors).

2. You can move the cursors with your mouse (click + hold + drag) along the signal curve.

3. You can see the instantaneous value of the signals 
at the cursor point (A and B) on the right side of 
the Oscilloscope window.

4. If you want to select different signals for 
visualization, refer to Set the signals on page 80 
for instructions.

CAUTION

Use the correct version of CMT 1000 to open waveform files. Waveform files that 
are saved with older CMT 1000 releases (3.xxx or 5.xxx) are not compatible with 
the CMT 1000 release 6.xxx.
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7.13.8.2 Examine a saved waveform file

The recorded data in a saved waveform file includes all of the 21 signals that you can select. 
Open other instruments to see the data. Some data is shown in the right side section of the 
Oscilloscope.

To examine a saved waveform file:

1. Make sure that CMT 1000 is offline.

2. Make sure that the cursors are enabled (Edit > Cursors).

3. Select the signals that you want to examine (refer to Set the signals on page 80).

4. Open the necessary instruments in accordance with the signals you want to examine.

5. Set the cursor A on the signal curve at the time point where you want to examine the 
transient data.

6. Open the related instrument. The related instrument shows the measurements at the 
time point.

7. Move the cursor A along the signal curve to examine the measurements in the related 
instruments.

8. If necessary, adjust the dimensions of the Oscilloscope. Refer to Adjust the buffer length 
on page 80.

Note! When you move the cursors along a signal curve, the instruments show 
historical data only if CMT 1000 is off-line. During monitor and control access the 
instruments show real-time measurements from the AVR.

7.13.8.3 Use a sweep buffer

A sweep buffer shows recorded transient data at real-time speed on the Oscilloscope and in 
the related instruments.

To use a sweep buffer:

1. Make sure that CMT 1000 is off-line.

2. Make sure that the cursors are enabled (Edit > Cursors).

3. Select the signals that you want to examine (refer to Set the signals on page 80).

4. Open the necessary instruments in accordance with the signals you want to examine.

5. Set the cursor A on the signal curve at the time point where you want to examine the 
transient data.

6. Open the Edit menu and select Sweep Buffer.

7. Cursor A goes automatically along the signal curve to the end of the transient data at 
real-time speed.

8. Open the related instruments. The selected instruments show the measurements at real-
time speed.

9. If necessary, adjust the dimensions of the Oscilloscope. Refer to Adjust the buffer length 
on page 80.
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An example of a sweep buffer:

7.13.9 Analog status signals
There are 4 analog signals that show status changes on the Oscilloscope. The decoding of 
those signals is explained as follows: 

Generator
Control Mode

Combined Limit1 GenState AlarmTripStatus

Signal Name Signal Name Signal Name Signal Name
0 Auto 0 None 0 Idle (NoLoad) 0 None

1 VAR 1 Minimum 
Excitation 

Current 
Limiter active 

(Min Ie)

1 Change 
NoLoad -> 

Primary Net

+1 SW Alarm 
active

2 PF 2 Minimum 
Machine 
Voltage 

Limiter active 
(Min UM)

2 Primary Net +2 FCB Alarm 
active

3 Manual 3 Minimum Iq 
Limiter active 

(Min IQ)

3 Change 
Primary Net 

<-> 
Secondary 

Net

+4 External 
Alarm active

4 Open Loop 4 Maximum 
Excitation 

Current 
Limiter active 

(Max Ie

4 Secondary 
Net

+8 Modbus 
Communicati

on Alarm 
active
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1) Notes on Combined Limit.

Excitation ON active: 

Combined Limit = See values above

Excitation ON not active:

Combined Limit = negative value

Emergency Excitation OFF = -16’384

An example of Combined Limit Status:

7.13.10 Problems with the Oscilloscope
If problems occur:

1. Make sure that the cabling is done correctly.

2. Make sure that the communication between the AVR and CMT 1000 is satisfactory.

During measurement errors, the Oscilloscope freezes and shows the last correct (error-free) 
measurement for each signal, until you find a solution to the problem. 

5 VDC 5 Maximum 
Machine 
Voltage 

Limiter active 
(Max UM)

5 Change 
Secondary 

Net -> 
NoLoad

+16 Diode Alarm 
active 

(requires 
RDM SW)

6 Sync 6 Reserved 6 Primary Net 
or Secondary 

Net -> Grid 
ON

+32 Diode Trip 
active 

(requires 
RDM SW)

7 Standby 7 Maximum 
Machine 
Current 

Limiter active 
(Max IM)

7 Grid ON +64 Supervision 
Alarm active 

(requires 
Double 

Channel SW)

+8 V/Hz Limiter 
active

8 Grid ON -> 
Primary Net 

or Secondary 
Net

+128 Supervision 
Trip active 
(requires 
Double 

Channel SW)

+16 Minimum 
Setpoint 
reached

+256 DCH 
SwitchOver 

active 
(requires 
Double 

Channel SW)

+32 Maximum 
Setpoint 
reached

Generator
Control Mode

Combined Limit1 GenState AlarmTripStatus

Signal Name Signal Name Signal Name Signal Name

None
Min Ie Active

Min Iq Active
Min UM Active

Max Ie Active
Max UM Active

V/Hz Limit Active

1.0

Combined Limit

+8

2.0
3.0
4.0
5.0

8.0
9.0

10.0
11.0

Min Ie Active + V/Hz
Min UM Active + V/Hz
Min Iq Active + V/Hz
Max Ie Active + V/Hz
Max UM Active + V/Hz

12.0
13.0

+8

s
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7.14 History Logger
History Logger records the last two hours of operation. Measurements from 12 defined 
signals are stored every minute in the non-volatile memory (EEPROM) of the AVR. History 
Logger requires the History Logger software.

You can use cursor A to show the data on the six measurement channels on the right. You can 
change the visualized signals. Cursor B shows the default values that are used with the 
Excitation OFF signal and each time that excitation starts.

You can monitor the signals that follow:

 

Signal Description Default value
Umrel Machine voltage 0 %

IM2rel Machine current 0 %

Qrel Reactive power 0 %

PWM AVR output (PWM) 50 %

GenState Generator state 0

Generator control mode Control mode 0

FMachine Machine frequency 0 Hz

Combined Limit Active limiters 0

Prel Active power 0 %

Upwr AVR input voltage (rectified) 0 V

Temperature DSP Temperature of the DSP 0°C
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7.14.1 Open a history log from your PC
To open a saved history log file from your PC:

1. Make sure that CMT 1000 is off-line.

2. On the right side of the main window of CMT 1000, select CMT 1000 for UNITROL 1020.

3. Open the Monitor menu of CMT 1000.

4. Select Data Logger.

5. In the Data Log Viewer window, select Open from Disk.

6. A new window opens.

7. In the CombineDataLogFile.vi window, click Change Path.

8. Select a data log file on your PC.

9. The data log file opens in the History Logger.
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8. Commissioning

This chapter gives an overview of the commissioning procedure. Only certified personnel can 
do commissioning of the AVR. Make sure to read and obey the safety instructions on Safety 
on page 13. 

For full instructions on how to do the commissioning of the AVR, refer to the UNITROL 1000 
Com-Instructions and PID tuning (3BHS399489 E01).

8.1 Precautions

Disconnect the system completely from power sources before commissioning. Secure 
against re-connection. Make sure that no measuring voltages or control voltages >50 V are 
present at the terminals. 

At an interrupted field circuit the input capacitor is slowly discharged through internal 
circuits.

In order to prevent unintentional closing of open voltage circuits by third parties, the circuits 
in question should be identified at the point of interruption (for example with a warning 
sign).

Before you start the unit, make sure that the connection terminals are wired up in accordance 
with the plant schematic.

WARNING

Do not touch the live parts of the AVR. Manipulation of live parts can cause death 
or injury, or damage to the machine. The unit operates with dangerous voltages of 
up to 300 V AC or 300 V DC as power input (and up to 500 V AC for machine and 
network voltage measurement).

WARNING

Be careful when you touch or connect the cables on the front plate of the AVR. 
There is a risk of electric shock. The secondary voltage of the excitation 
transformer and the voltage of the excitation field are fed into the excitation 
cabinet.
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8.2 Commissioning procedure
This section provides an overview of the commissioning procedure. For detailed instructions 
on commissioning, refer to UNITROL 1000 Com-Instructions and PID tuning (3BHS399489 
E01).

Commissioning procedure overview:

1. Make sure that all of the connections are correct and safe.

2. Download the configuration file to the AVR. Make sure that the parameters are correct.

3. Examine the digital and analog I/Os in standstill.

4. Do tests with the machine:

a) Standstill
• Measure the resistance of the exciter stator winding.

b) No-load condition
• Increase the speed of the machine to nominal.

• Start excitation in Manual mode and increase the manual setpoint until machine 
voltage is at 50 %.

• Use CMT 1000 to verify the AVR measurements and compare them with other 
equipment used, such as protection devices.

• Increase the setpoint until the machine voltage is at 100 % and tune the AVR with the 
AVR tuning assistant.

• Do step response tests to examine performance in Manual mode and Auto mode.

c) Machine connected to the grid
• Select Auto mode (voltage regulator).

• Increase the voltage setpoint to verify the polarity of the of IM measurement. Q must 
increase.

d) Do step response tests to examine performance in Auto mode and direct VAR regulator 
modes.

5. Finalizing commissioning
• Save the parameters on the AVR and verify the status with CMT 1000.

• Save backup files for project documentation.

WARNING

To prevent unstable regulation and damage to the machine, do tests for all used 
regulator modes and limiters.

WARNING

If you use synchronization, refer to the procedure in the UNITROL 1000 Com-
Instructions and PID tuning (3BHS399489 E01). Take special care with 
synchronization to prevent physical injury or death, or damage to the equipment.
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9. Operation

This chapter gives instructions on how to operate the AVR. Before you operate the AVR, read 
and understand the safety instructions in Safety on page 13. Only qualified personnel are 
permitted to operate the AVR. Operating personnel must be familiar with the excitation 
system and the related safety hazards.

Note! ABB recommends periodical training for operating personnel.

9.1 Operators and access levels
The measurement and control unit (DSP) of the AVR manages the access level statuses and 
priorities of the operators. Digital inputs have the highest priority to control the AVR. Thus, 
the AVR is by default in local control with digital inputs. Each operator has a specified priority 
that has an effect on access requests (refer to Priority of the operators on page 91 and 
Access requests on page 91).

In addition to digital inputs, you can control the AVR with two operators:

• CMT 1000 (refer to Commissioning and maintenance tool CMT 1000 on page 54)

• Remote access (refer to the Modbus Reference Manual (3BHS358281 E80))

9.1.1 Access level statuses
All operators can have monitor access to read data at the same time. Only one operator at a 
time can have control access to read and write parameters.

9.1.1.1 CMT 1000

The access level status of CMT 1000:

• Offline (no access)

If the status is offline, the micro-controller unit (MCU) of the AVR considers the operator 
as disconnected to the AVR. If CMT 1000 senses a compatible AVR, only the AVR-ID, 
channel identification, and time and date are updated.

DANGER

Dangerous voltage. There is a risk of electric shock.

CAUTION

Do not change parameters after commissioning before you think about the 
consequences of parameter changes. If you run the excitation system with 
incorrect data, it can cause incorrect operation, decrease the control accuracy and 
cause damage to the equipment.
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• Monitor access (read)

With monitor access, you can read data from the AVR. It is not possible to change 
parameters.

• Control access (read and write)

With control access, you can have full control of the AVR. You can read and write data.

9.1.1.2 Remote access

Send an access request through Modbus. For information on remote access, refer to the 
Modbus Reference Manual (3BHS358281 E80).

9.1.2 Priority of the operators
The priorities of the operators are:

• Local control with digital inputs (default)
The AVR is by default in local control with digital inputs. After other operators disconnect, 
the AVR goes back to local control.

• CMT 1000 (medium priority)
When CMT 1000 has control access, other CMT 1000 applications or plant control system 
over remote access cannot get control access. When you set CMT 1000 to off-line, the 
AVR goes back to local control with digital inputs.

• Remote access (lowest priority)
You can get control access with a remote access connection only if the AVR is in local 
control with digital inputs and no other operators have control access.

9.1.3 Access requests
The access level status of each operator is stored in the measurement and control unit (DSP). 
The status information is used to give and deny access requests. 

All operators can send a request to have control access. The measurement and control unit 
(DSP) gives the access to only one operator at a time, based on the priority of the operator. 
Typically all requests to change the access level to monitor access are approved, because all 
operators can read data from the AVR at the same time.

Access requests are not approved if:

• More than one CMT 1000 tries to connect to the same AVR

• More than 10 independent remote access connections try to connect to the same AVR

Note! If these limitations are surpassed, one or all of the connected operators can 
lose their access and go off-line. This practice is not recommended by ABB.
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10. Troubleshooting

This chapter gives instructions on how to find faults in the excitation system. Note that this 
chapter does not fully include all possible faults. Before you start to do work on the excitation 
system, make sure that you read and understand the safety instructions in Safety on page 13.

10.1 Evaluate AVR operation
To evaluate the correct operation of the AVR:

1. Make sure that the green status LED flashes on the AVR. Refer to Status LEDs on page 20.

2. Connect CMT 1000 to the AVR. Open the Setpoint Adjust window (Tune menu > Setpoint 
Adjust) and make sure that the settings and operation point are correct. Refer to 
Setpoint Adjust on page 69.

10.2 A list of possible faults
The table below includes possible faults that can occur in the excitation system. The list 
includes also the procedure how to examine the fault.

Possible faults:

• The machine cannot be excited (on page 92)

• The machine voltage cannot ramp up (on page 93)

• The machine overvoltage after start-up (on page 94)

• The voltage is not stable in no-load operation (on page 95)

• The machine is not stable in island operation with other machines on the same busbar. 
A period of oscillation of reactive power and possibly active power (on page 95).

• The machine is not stable in parallel to the grid operation. A period of oscillation of 
reactive power and possibly active power (on page 96).

10.2.1 Machine cannot be excited

Fault Cause/Indication Procedure

Excitation is not on. Excitation ON command is 
not received. 
Setpoint Adjust window 
shows a gray background on 
the active mode.

Examine the digital inputs or 
remote control setup.
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10.2.2 Machine voltage cannot ramp up

Excitation is not on. Excitation is blocked.
Setpoint Adjust window 
shows a red background on 
the active mode.

 Make sure that:
• Emergency Excitation OFF 

digital input is not active
• Start frequency is reached 

as defined in Soft Start
• UPWR threshold is reached 

as defined in Soft Start

The field circuit breaker 
does not close.

Wiring or digital inputs are 
not correct.

Examine the wiring of the 
field circuit breaker.
If you use the FCB control 
function, make sure that the 
“FCB closed Status” digital 
output is correct.

Fault Cause/Indication Procedure

The machine voltage cannot 
ramp up with shunt supply 
and field flashing support.

Field flashing does not 
supply the necessary 
voltage to ramp up the 
machine voltage.

Examine the circuit breaker 
that is related to field 
flashing.
Make sure that the input 
voltage for field flashing is 
at 20 % or more of the 
machine voltage.

The machine voltage cannot 
ramp up with shunt supply 
only.

Start-up is based on the 
residual magnetism of the 
machine. The residual 
magnetism of the machine 
does not provide the 
necessary supply voltage to 
ramp up the machine 
voltage.

Increase the residual 
magnetism of the machine.
Follow the machine 
instructions.

No power electronics supply 
UPWR.

Wiring is not correct. Examine if a protective 
circuit breaker is open.
Measure the power 
electronics supply UPWR with 
the Oscilloscope.

Machine voltage cannot 
ramp up after you have 
examined the above- 
mentioned points and 
setpoints.

V/Hz limiter is active. V/Hz 
limiter ramp up is set to 
100 %. Machine voltage 
cannot ramp up because the 
setpoint is set to 0 %.

Set the V/Hz Limiter ramp 
up to 90 %.

Fault Cause/Indication Procedure
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10.2.3 Machine overvoltage after start-up

Machine voltage cannot 
ramp up after you have 
examined the above- 
mentioned points and 
setpoints.

Machine voltage cannot 
ramp up because of the 
initial setpoint settings.

Examine the initial setpoint 
settings.
Make sure that the initial 
setpoint is more than 0 %.

Machine voltage ramps up 
for a short time before 
excitation goes stops.

A supervision trip is active 
and forces the excitation to 
stop.

Examine the active 
supervision functions.
Clear the alarms and trips.

Fault Cause/Indication Procedure

High overvoltage of the 
machine.

The voltage setpoint is not 
correct because of incorrect 
PT settings.

Examine the system data 
parameters and PT settings.

A short period of machine 
overvoltage after start-up.

Especially with a shunt 
supply, the ramp up of 
excitation can take more 
time than expected.
The ramp time is too short 
or hold time is not used.

Examine the soft start 
settings.
Make sure that you use hold 
time to get stable operation 
before the ramp up starts.
Make sure that the ramp 
time is long enough.

A short period of machine 
overvoltage after start-up. 
Field flashing is used.

Field flashing is switched off 
too late.
Or the applied field flashing 
voltage is too high and it 
causes a too high excitation 
current.

Examine the parameters for 
field flashing.

Bad voltage regulation. Tuning is not done correctly. Do a step response test and 
examine the result with the 
Oscilloscope to examine the 
tuning of the AVR.
Use the PID tuning assistant 
to get a correct tuning.

Fault Cause/Indication Procedure
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10.2.4 The voltage is not stable in no-load operation

10.2.5 Machine is not stable in island operation

Fault Cause/Indication Procedure

Bad voltage regulation. Tuning is not done correctly. Do a step response test and 
examine the result with the 
Oscilloscope to examine the 
tuning of the AVR.
Use the PID tuning assistant 
to get a correct tuning.

Fault Cause/Indication Procedure

The operation point is not 
stable.

Reactive load sharing does 
not operate correctly.

Examine the operation 
mode and droop settings 
You must have: 
• Auto mode with negative 

Kq settings
• or VDC mode with 

negative Kq setting
Make sure that each 
machine operates with the 
same voltage setpoint and 
Kq settings.
Typically Kq is set at -4 %.

One or more machines have 
an active limiter.

Typically the PQ limiter 
activates to keep the 
machine voltage within the 
permitted operation point.
Reactive load sharing does 
not operate if one or more 
machines are not in Auto 
mode or VDC mode.
If one or more machines is 
operated in Manual mode, 
for example after local load 
application or rejection, the 
reactive load is not shared 
equally between the 
machines.

Make sure that each 
machine is operated in Auto 
mode or VDC mode.
Make sure that the reactive 
load is shared equally 
between the machines on 
the same busbar.

Oscillations of the active 
power.

An external governor control 
or an incorrect cylinder 
firing of the machine can 
cause oscillations of the 
active power.

Use the Oscilloscope to 
examine the oscillations.
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10.2.6 Machine is not stable in parallel to the grid operation

10.3 Defective unit

If the AVR is defective, send it to the service center with a detailed description of the fault or 
failure. Contact ABB for information on your local service center. Refer to Support 
information on page 10.

Fault Cause/Indication Procedure

The operation point is not 
stable. PSS is not active.

Network conditions have 
changed.
PID settings are too 
aggressive.

Evaluate the external 
reactance.
Use the PID tuning assistant 
to get a correct tuning.

The operation point is not 
stable. PSS is active.

PSS settings are too 
aggressive.
Or PSS tuning is not correct.

Use the PSS tuning assistant 
to evaluate the correct PSS 
tuning.

DANGER

Do not open or remove the metal front cover that protects the AVR.

CAUTION

Before you replace an AVR with a spare unit, make sure that you save 
the parameters to your PC. Refer to Upload a parameter file to your PC on page 75.
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11. Technical data

This chapter gives the technical data of the AVR.

11.1 Dimensions

Dimensions and weights
D1 W1 W2 H1 H2 Weight

mm in mm in mm in mm in mm in kg lb
72 2.8 161 6.3 80 3.1 230 9.1 215 8.5 1.5 3.3

D1

H2

W2

W1

H1
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11.2 Electrical data

Electrical data of the power and measurement terminals

Power supply input (AC/DC)

AC nominal voltage (sinusoidal) 16 - 250 V AC

AC voltage (maximum sinusoidal)1 Maximum 300 V AC

Frequency 40 - 600 Hz

DC nominal voltage 25 - 300 V DC

Maximum DC voltage 420 V DC

Maximum peak voltage (non-sinusoidal) 420 V peak

Test voltage for 1 min 2.8 kV DC

Maximum power consumption 
(only internal electronic circuits)

7 W

Maximum crowbar firing current for 10 ms 100 A rms

Power supply input (startup)

Single-phase voltage 6.0 V AC

DC voltage 16.0 V DC

Auxiliary supply for controller only

DC nominal input voltage 18 - 30 V DC

Excitation output

Continuous current at 55 °C 8 A

Continuous current at 70 °C 5 A

Maximum current for 10 s at 55 °C 16 A

IGBT and free wheeling diode

Maximum forward voltage of an integrated 
free wheeling diode (25 °C, IF = 8 A)

2.6 V

Maximum reverse voltage of a free wheeling 
diode

600 V
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Derating factor (m.a.s.l. >1000 m)

For installation altitude higher than 1000 m 
above sea level, a derating factor (kH) 
applies to the nominal excitation current 
(Ie).
In the formula, h is the installation height of 
the application in meters above sea level.
It is not necessary to reduce nominal 
voltages, but external overvoltage 
protection must be adjusted.

kH = 1 - 85.7 E-6 (h - 1000 m)

Voltage regulation

Accuracy at 25 °C 0.2 %

AVR response time
(three-phase / single-phase measurement)

< 20 ms / < 50 ms

PWM limitation 0.5 - 99 %

Exciter current measurement

Full range 0 - 25 A DC

Accuracy after a digital filter Maximum +/- 1 %

Resolution of a sensor 20 mA

Machine voltage measurement

Nominal voltage (maximum) 3 x 500 V AC

Full range voltage (phase to phase) 700 V AC

Input impedance 6.0 MOhm

Test voltage for 1 min 2.8 kV DC

Accuracy2 (-40 to 70 °C / 25 °C) +/- 1 % / 0.1 %

Network voltage measurement

Nominal voltage (max.) 1 x 500 V AC

Full range voltage (phase to phase) 700 V AC

Input impedance 6.0 MOhm

Test voltage for 1 min 2.8 kV DC

Accuracy2 (-40 to 70 °C / 25 °C) +/- 1 % / 0.1 %

Machine current measurement

Nominal current 1 / 5 A 

Full range current 2.8 / 13.4 A AC

Electrical data of the power and measurement terminals
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1: A maximum of a 300 V AC input voltage is permitted. Note that a higher voltage causes severe damage to the 
unit.

2: Frequency bandwidth: 10 - 200 Hz. Define the accuracy up to 150 Hz with 3 % and up to 200 Hz with 10 %.

Note! Do not load the device for 100 times the defined duration, if an overcurrent 
occurs.

Maximum current for 10 s (1 A) 4 A rms

Maximum current for 1 s (1 A) 8 A rms

Maximum current for 10 s (5 A) 22 A rms

Maximum current for 1 s (5 A) 38 A rms

Accuracy Maximum +/- 1 %

Resolution Maximum 0.1 %

Overcurrent capability for excitation output

Duration 3 s 10 s 20 s 30 s 1 min 2 min 5 min cont. units

Ambient 
temperature

55 °C 24 16 14 12 11 10 9 8 A

60 °C 21 14 12 11 10 9 8 7 A

65 °C 18 12 11 10 9 8 7 6 A

70 °C 16 10 9 8 7 6 5.5 5 A

Electrical data of the analog and digital inputs and outputs

Analog input +/- 10 V

Full range peak voltage +/- 10 V

Input impedance 1100 kOhm

Common mode range +/- 15 V

Accuracy < +/- 1 %

Resolution 10 mV

Analog input 20 mA

Full range peak voltage 20 mA

Input impedance 100 Ohm

Common mode range +/- 15 V

Electrical data of the power and measurement terminals
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Note! The maximum cable length for digital and analog input and output cables is 
30 m. Refer to Control cabling requirements on page 27.

Accuracy < +/- 1 %

Resolution 0.1 mA

Digital inputs

Number of inputs 8

Input impedance to GND 2.2 kOhm

GND reference PE

Input voltage range 0 - 28 V

Digital input thresholds (high/low) 13 V / 5 V

Digital outputs, isolated

Number of isolated outputs 2

Voltage range of 24 V output 21 - 25 V

Maximum output current 24 V output 50 mA

Digital outputs, non-isolated

Number of outputs 2

Voltage range of 24 V output 21 - 25 V

Maximum output current 24 V output 500 mA

24 V output for contacts

Maximum 24 V driver current (to GND) 50 mA

Electrical data of the communication interfaces

Ethernet interface

Data rate 10/100 MBit/s

Maximum cable length 100 m

Auto-MDIX

Auto-negotiation and parallel detection

Isolation to PE 1 kV DC

USB service interface

Data rate 12 MBit/s

Maximum cable length 3 m

Electrical data of the analog and digital inputs and outputs
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11.3  Environmental data

USB version 1.0, 2.0

Environmental data

Permitted ambient temperature

Maximum storage temperature 0 - 55 °C

Recommended storage temperature 25 °C

Operating temperature -40 - 70 °C

Maximum heat sink temperature 90 °C

Mechanical stability

Vibration, IEC60068-2-6 DNV class B

Shock and bump, IEC 60255-21-2 Class 2

Seismic, IEC 60255-21-3 Class 2

EMC immunity

EN 61000-6-2 (Generic immunity standard)

EMC emission

IEC 61000-6-4 (Generic emission standard)

Isolation coordination

IEC60664-1

cUL certification (CSA compliant) (pending)

UL 508, user group

File number Pending

DNV certification (pending)

Housing

Protection class of housing IP20

Pollution degree 3

Dimensions L x W 230 x 161 mm

Height 72 mm

Weight 1.5 kg

Electrical data of the communication interfaces
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11.4 Markings

11.5 UL certification (pending)
To use the AVR in a UL compliant way, obey these rules:

• Maximum ambient temperature is 70 °C.

• Maximum output capability at 70 °C 5 A / 150 V

• Use only 60/75 °C wires.

• Use only in a Pollution Degree 2 environment.

• Identify the correct connections with marks for for the power supply, control and load.

• Identify the grounding conductor terminal plainly with “PE”.

11.6 Reliability

UNITROL 1005

MTBF (MIL-HDBK-217F) GB (40°) 32.4 years

Failure rate in time GB (40°) 3562 FIT

Operational lifetime of capacitors > 150,000 h

Average ambient temperature 40 °C

Input power Three-phase

Exciter current 8 A

CE marking      DNV.COM/AF      SQS
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11.7 Storage and recycling
Follow the storage procedures to avoid damage or a degradation of quality due to corrosion, 
dirt or mechanical damage. Take precautions from the time the unit goes to storage until the 
time you take the unit out of storage and install it.

Make sure to recycle:

• Packing materials

• Unit components

11.7.1 Storage conditions
Put the unit to storage in the original product package. Make sure that the environmental 
conditions are in the permitted range during storage. ABB recommends to keep the ambient 
temperature and the relative air humidity constant. Refer to Environmental data on page 102 
for more information. 

11.7.2 Recycling instructions

The unit has materials that can be used as raw materials for recycling. Speak to your local 
waste disposal company for an ecological separation of materials and waste management.

Obey the local regulations to discard:

• Batteries

• Capacitors

• Electronic components

• Printed circuit boards

Note! Only a licensed waste disposal company can remove and recycle printed 
circuit boards. It is necessary to remove any environmentally hazardous 
components from the printed circuit boards.

It is possible to discard the unit by manual disassembly or mechanical shredding.

CAUTION

Only qualified personnel can discard electrical equipment. The inappropriate dis-
posal of electrical equipment can cause an environmental hazard.
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11.7.2.1 Manual disassembly

1. Disassemble the unit manually into materials. 

2. Follow the local regulations to recycle the materials that follow:
• Aluminum (cabinets, heat sinks)

• Copper

• Iron

• Plastics

3. Remove any environmentally hazardous components such as capacitors from the printed 
circuit boards.

4. Follow the local regulations to recycle the materials that follow:
• Batteries

• Capacitors

• Electronic components

• Printed circuit boards

11.7.2.2 Mechanical shredding 

1. Remove dangerous materials and components that can cause damage to the 
environment.

2. Put the unit in a shredding machine.

3. The unit is mechanically shredded into small pieces.

4. Recycle the materials.

11.8 Ordering information

Description Order code Order text

UNITROL 1005-0011 ECO 3BHE043576R0011

UNITROL 1005-0012 LIGHT 3BHE043576R0012
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11.9 Settings record for the AVR

Settings record

Name and address of 
customer

Plant

Order No.

Plant schematic No.

Device identification

Type plate

Delivery date

Software revision

Device software

CMT 1000

Remarks

Place and date of 
commissioning

Name Company
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